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1. Introduction 
Ce guide fournit  toutes les informations nécessaires à ceux qui sont intéressés par la création de 

leurs propres scènes pour la version 2. Le processus de création de scènes est décrit, ci-dessous lors 

de la création d'une petite scène de démonstration appelée "Tutorial". Bien que la plupart des étapes 

du processus puissent être effectuées dans divers logiciels, nous n'utiliserons dans ce guide que des 

logiciels gratuits ou dont les codes sources sont libres. 

Le texte de ce guide est divisé en plusieurs chapitres. 

• Chapitre 2 : Aperçu de toutes les nouvelles fonctionnalités des scènes de Condor 2 en 

comparaison avec la version 1. 

• Chapitre 3 : Aperçu de toutes les informations techniques relatives aux scènes Condor 2. 

• Chapitres 4 et 5 : Première partie du didacticiel de la création de scène. Description du 

processus d'obtention et du traitement des sources de données d'élévations, importation de 

ces données dans "Landscape Editor" et exportation du terrain de base de la scène en Cv2. 

• Chapitre 6 : Comment ajouter des textures, des cartes de forêts, des cartes thermiques et 

des effets sur l'eau aux scènes sur les tuiles de la scène ? 

• Chapitre 7 : Brève introduction à la modélisation des aéroports et des objets 3D 

personnalisés. Comment ajouter des aéroports, des objets 3D personnalisés et des points de 

virage à la scène et conclusion sur le didacticiel de démonstration ? 

• Chapitre 8 : Évaluation de tous les problèmes liés à la conversion des scènes  V1 pour une 

utilisation dans Condor 2. 
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2. Quoi de neuf dans les scènes de Condor 2 ? 
Condor, dans sa version 2 (V2 à partir de maintenant) offre le même niveau de possibilités aux 

constructeurs de scènes que la version 1 originale de Condor (V1 à partir de maintenant). Tout le 

monde peut créer une scène et la publier pour tous les utilisateurs de la V2. 

Les différences clés et les nouvelles fonctionnalités des scènes V2 sont listées ci-dessous. 

• Le maillage du terrain a diminué. Il passe, de 90 m dans la V1, à 30 m dans V2. Le terrain pour 

les scènes V2 est construit à partir de données DEM de 1 seconde d'arc. Le maillage du 

terrain résultant est plus net et présente mieux les diverses caractéristiques physiques de la 

scène qui ont été «moyennées» dans les scènes V1 avec un relief constitué de données de 3 

secondes d'arc (90 m). 

• La taille standard de la texture des tuiles de la scène est maintenant de 8192 x 8192 pixels 

(c'est-à-dire 2048 x 2048 pixels par tuilettes ou "patches"). 

• Les cartes des forêts prennent désormais en charge une résolution allant jusqu'à 2048 par 

2048 pixels par tuile de la scène, ce qui permet une meilleure précision du placement des 

arbres. 

• Tous les arbres sont générés automatiquement à l'aide de cartes des forêts. Ils ont 

maintenant une taille réaliste et les zones de forêt ont une densité d'arbres supérieure à 

celle des arbres surdimensionnés et moins denses de V1. 

• Les textures des scènes peuvent, maintenant, contenir des aires aquatiques, dont le rendu 

sera défini à l'aide de "Shaders", provoquant des effets sur la surface de l'eau plus réalistes. 

• L'ensemble de la scène et tous les objets sont maintenant dynamiquement éclairés et 

ombrés en fonction de la date et de l'heure du vol dans le simulateur. 
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3. Aperçu technique des scènes Condor 2 
Avant de commencer à créer des scènes, nous devons expliquer comment Condor traite les données 

géographiques et comment fonctionnent les scènes de Condor 2. 

Le premier élément important réside dans le fait que Condor cartographie tout le terrain sur un plan. 

Comme la Terre est essentiellement une sphère (ou un ellipsoïde pour être plus précis), nous avons 

besoin d'un moyen de projeter les données géographiques réelles sur un plan à deux dimensions. 

Condor utilise la projection cylindrique UTM en référence à l'ellipsoïde WGS 84. 

La projection de grandes zones entraîne un certain niveau d'erreur de projection. Pour éviter de tels 

problèmes, la projection UTM divise la surface de la Terre en 60 zones qui sont utilisées comme 

référence par la projection. Cependant, Condor n'est pas capable de travailler en mélangeant 

plusieurs zones UTM dans une même scène. 

Si vous décidez de faire une grande scène qui chevauche plusieurs zones UTM, vous devez choisir 

une seule zone UTM de référence, de préférence la zone où se trouve la plus grande partie de la 

scène (ou la zone centrale de la scène). Les parties de la scène appartenant à d'autres zones UTM 

seront soumises par le calcul à la projection de la zone UTM de référence. Mais pour garder un 

niveau d'erreur de projection acceptable, il est recommandé de ne pas aller plus loin que 2-3 degrés 

dans les zones UTM voisines. 

 

Utilisez l'application "UTMtools" pour vérifier si la zone que vous souhaitez inclure 
dans votre scène se trouve à l'intérieur d'une zone UTM ou chevauche plusieurs 
zones, et pour convertir les coordonnées des zones adjacentes en coordonnées 
UTM de la zone centrale. 

Une scène de Condor est divisée en tuilettes, ou, "patches". Dans Condor, la tuilette, ou "patch" est 

l'unité de base physique de la scène et recouvre une superficie carrée de 5,76 x 5,76 km. Comme les 

plus petites scènes se composent de centaines et les plus grandes scènes de milliers de tuilettes, 

travailler au niveau de la tuilette pourrait être très inefficace et prendre beaucoup de temps. Pour 

faciliter la création et le traitement des textures et des cartes de données associées (cartes de forêt, 

etc.), les tuilettes sont rassemblées en "tuiles". Chaque tuile est composée de 16 tuilettes, organisées 

en un carré, de 4 x 4 tuilettes, de dimension de 23,04 x 23,04 km. 

Lorsque vous travaillez dans "Landscape Editor", tout est défini au niveau de la tuile. La scène en 

entier est fondamentalement composée d'un tableau assemblé de tuiles, de Nc colonnes, et Nr lignes 

de tuiles. Chaque fichier lié à une tuile particulière contient dans son nom les coordonnées de la 

tuile. Il n'y a pas de limites pour la taille d'une scène, mis à part l'espace mémoire et les limitations 

inhérentes à la projection UTM. 

 

Les dimensions Est (largeur) et Nord (hauteur) d'une scène Condor doivent être 
des multiples entiers de 5,76 km, il est donc possible de créer des scènes où 
certaines tuiles de textures ou de cartes seront incomplètes en bordure Nord ou 
Ouest. 
Dans notre tutoriel, nous allons travailler uniquement avec des tuiles entières, car 
c'est la façon la plus simple de travailler dans "Landscape Editor"(l'Éditeur de 
scène). Lorsque vous travaillez avec des tuiles entières, les dimensions de la scène 
doivent donc être des multiples entiers de 23,04 km. 
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L'appellation des fichiers et la numérotation des tuiles commencent à partir de zéro (et non de 1) et 

incluent leurs coordonnées. La structure générale des coordonnées est de la forme "CCRR", où "CC" 

est le numéro de la colonne et "RR" est le numéro de la rangée de la tuile considérée - "CC" et "RR" 

incluent un zéro si leur valeur est inférieure à 10 (ex : 0506 pour la tuile se trouvant à l'intersection de 

la 6ème colonne et de la 7ème ligne). L'origine des coordonnées des tuiles se trouve toujours dans le 

coin inférieur droit de la scène. La coordonnée maximale de la colonne est donc : Nc - 1, la 

coordonnée maximale de la rangée est donc : Nr - 1. 

Par exemple : une scène de 4 x 3 tuiles se compose de 12 tuiles organisées en un tableau de 4 

colonnes et de 3 rangées. Les numéros des coordonnées des colonnes et des lignes d'une tuile 

commencent à 0 et sont comptés à partir du coin inférieur droit (4 colonnes numérotées  0, 1, 2, 3, et 

3 lignes numérotées 0, 1, 2). L'appellation, par la numérotation des coordonnées, de la tuile en bas à 

droite est 0000, et pour la tuile supérieure gauche c'est 0302. 

Le système de coordonnées des tuilettes est basé sur les mêmes principes que le système de 

coordonnées des tuiles. Les tuilettes sont automatiquement créées à partir des fichiers des tuiles 

sources à l'aide de divers outils du "Condor Landscape Toolkit".  

Par exemple : la scène composée de 4 x 3 tuiles de l'exemple précédent est divisée en 192 tuilettes 

organisées en un tableau de 16 x 12 tuilettes. La numérotation des coordonnées de la tuilette 

inférieure droite est 0000, et celle de la tuilette supérieure gauche est 1511. 

 

Bien que le système de coordonnées soit le même que dans V1, les textures de 
tuilettes formatées à partir de V1 ne peuvent pas être utilisées directement dans 
V2 sans être reformatées, car elles sont tournées de 180 degrés. Plus 
d'informations à ce sujet dans le chapitre 6. 

 

Si vous avez besoin d'un moyen rapide de savoir qu'elle est la tuile, à laquelle 
appartient une tuilette, il suffit de diviser chacune de ses coordonnées par 4 et la 
partie entière du résultat vous indique les coordonnées de la tuile source. Les 
coordonnées des tuilettes et des tuiles sont également affichées dans "Landscape 
Editor" (l'Éditeur de Scène).  
Par exemple : Pour trouver la tuile source de la tuilette 1307, nous divisons les 
deux coordonnées par 4 : 
 
13/4 = 3.25 - le nombre entier 3 fait partie du résultat  
7/4 = 1,75 - le nombre entier du résultat est 1 
 
Nous obtenons les coordonnées de la tuile source en combinant le nombre entier 
des résultats partiels - Cette tuilette ou "patch" fait partie de la tuile 0301. 
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4. Créer le terrain pour notre scène 
Ce chapitre décrit les premières étapes du tutoriel de création de scènes. Nous utiliserons le logiciel 

"SIG" (Système d'Information Géographique) open source de "QGIS" pour traiter les données de 

terrain et "RawToTrn" et "Landscape Editor" du "Condor Landscape Toolkit" pour les importer dans 

Condor. 

Nous avons déjà mentionné quelques faits importants concernant les scènes de Condor. La 

projection UTM, la taille des tuilettes de 5,76 km et la taille des tuiles de 23,04 km seront maintenant 

très importantes. 

Comme mentionné précédemment, le maillage du terrain dans V2 a été diminué à 30 m (1 seconde 

d'arc). Les données dans une telle résolution sont maintenant disponibles à partir de plusieurs 

sources pour le monde entier gratuitement. Dans notre exemple, nous utiliserons les données de 

l'USGS en utilisant leur service "Earth Explorer". 

Cependant, avant de commencer à télécharger les données depuis "Earth Explorer", nous devons 

d'abord décider de l'emprise de la zone couverte par notre scène "Tutorial" et trouver au moins les 

coordonnées approximatives de son coin supérieur gauche et inférieur droit. 

Pour rester simples, nous n'utiliserons qu'une petite zone dans le centre de la République tchèque. 

Vous pouvez bien sûr utiliser un emplacement différent et augmenter la taille de la scène. Toutes les 

étapes décrites dans ce tutoriel s'appliqueront. 

Les coordonnées du coin supérieur gauche et du coin inférieur droit peuvent être estimées à partir 

d'une carte en papier ou lues à partir de diverses sources de cartes électroniques ou même d'un 

"SIG". Dans notre cas, nous utiliserons "Google Maps". 

 

Figure 1 - Trouver les coordonnées dans "Google Maps" 

Ouvrez la carte et effectuez un zoom avant ou arrière pour afficher toute la zone que vous souhaitez 

inclure. Puis cliquez sur l'endroit dans la carte où le coin supérieur gauche de votre scène sera situé. 
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Si vous souhaitez localiser l'emplacement plus précisément, effectuez un zoom avant. Une petite 

fenêtre contextuelle doit apparaître au bas de la carte, indiquant le nom de la ville ou du village 

auquel appartient cet emplacement et les coordonnées géographiques décimales du point 

sélectionné. Notez les coordonnées ou copiez-les dans "UTMtools". Dans notre cas, les coordonnées 

du point en haut à gauche sont N 49.996706 et E 15.289449. Ces coordonnées seront les 

coordonnées définitives et réelles du coin supérieur gauche de notre scène. 

Nous répéterons les mêmes étapes pour le coin inférieur droit de notre zone d'intérêt. Comme notre 

région contient la crête des Montagnes de Fer, qui est utilisée pour le vol de pente, nous essaierons 

de l'inclure dans notre scène et notre coin inférieur droit estimé sera un peu au Sud-est de "Ždírec 

nad Doubravou" aux coordonnées N 49.666849 et E 15.848711. 

Contrairement aux coordonnées du coin supérieur gauche, qui représentent réellement le coin 

supérieur gauche de notre scène, les coordonnées en bas à droite ne représentent que la limite de 

notre zone d'intérêt, car les dimensions de la scène finale doivent être un multiple entier de la taille 

d'une tuile. 

 

Une fois que nous avons les coordonnées latitude/longitude en haut à gauche et en bas à droite, 

nous devons les convertir en coordonnées UTM. Pour ce faire, nous pouvons utiliser l'un des divers 

convertisseurs UTM latitude/longitude en ligne, tels que : 

http://home.hiwaay.net/~taylorc/toolbox/geography/geoutm.html,  

ou nous pouvons faire tous les calculs automatiquement en utilisant "UTMtools". Nous allons 

montrer les deux approches dans ce tutoriel. Notez que si votre scène s'étend sur plusieurs zones 

UTM, vous devrez calculer les coordonnées UTM en utilisant la zone centrale de référence, et non la 

zone à laquelle le point appartient réellement. Ce type de calcul n'est généralement pas pris en 

charge par les convertisseurs en ligne. Utilisez "UTMtools" à cette fin. 

 

Voir http://geokov.com/education/utm.aspx pour un bon aperçu de la projection 
UTM, des zones UTM et de la théorie des coordonnées UTM. 

Calculs manuels 
La conversion des coordonnées nous donne des résultats sous forme de nombres décimaux avec 

beaucoup de décimales. Pour les scènes de Condor 2, nous n'avons besoin que de la partie entière de 

 

Comme les données d'élévation du terrain dans la simulation ne sont disponibles 
que pour la zone de la scène, Condor ne permet pas de voler à moins de 5 km (une 
distance de tuilette) de la bordure de la scène. Là, le planeur fera face à un mur 
invisible qui l'empêchera de voler plus loin. 
 
Cette particularité doit être prise en compte lors de la planification de la zone 
couverte par votre scène. Si vous souhaitez inclure un point d'intérêt (aéroport ou 
point de virage important) qui s'avère très proche de la bordure de votre scène, il 
est recommandé d'étendre la zone dans cette direction. Sinon, il se peut qu'il ne 
soit pas possible de voler en toute quiétude dans son voisinage. 

http://home.hiwaay.net/~taylorc/toolbox/geography/geoutm.html
http://geokov.com/education/utm.aspx
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ces données qui sont exprimées en mètres. Les coordonnées UTM consistent en une valeur 

d'orientation (axe X ou E : coordonnée longitudinale, vers l'Est) et une valeur d'orientation (axe Y ou 

E : coordonnée latitudinale, vers le Nord). Nous devons également savoir à quelle zone 

appartiennent les coordonnées de ce point, et, dans quel hémisphère du globe (N ou S) il se trouve. 

Les coordonnées UTM de notre coin supérieur gauche sont : 

 X1 = 520745 m, Y1 = 5538304 m, zone 33N. 

Les coordonnées UTM de notre coin prévisionnel en bas à droite sont : 

Xp2 = 561243 m, Yp2 = 5501936 m, zone 33N (p pour prévisionnel). 

Comme à l'intérieur d'une zone UTM, nous pouvons tirer parti du fait que les coordonnées UTM sont 

en fait des distances en mètres d'un point d'origine donné et calculer simplement les dimensions de 

notre zone d'intérêt en soustrayant les valeurs, Est et Nord, de ces 2 points. 

Ainsi pour notre scène : 

Dimension Est (Largeur) = Xp2 - X1  

=> 561243 - 520745 = 40498 mètres 

Dimension Nord (Hauteur) = Y1 - Yp2 

=> 5538304 - 5501936 = 36368 mètres 

Les dimensions de notre zone d'intérêt est donc de 40498 x 36368 mètres. Étant donné que la taille 

d'une tuile de la scène est de 23040 mètres, notre zone s'étend sur environ 1,76 x 1,58 tuile (ou 

environ 7,03 x 6,3 tuilettes). Comme nous allons travailler au niveau de la tuile et que la scène doit 

être composée de tuiles entières, nous avons deux options. Nous pouvons soit rejeter la partie de la 

zone appartenant à des tuiles incomplètes et faire une scène plus petite ou inclure plus de terrain 

pour obtenir une scène avec des tuiles entières. Notre scène finale sera alors un peu plus grande. 

Pour notre exemple, nous choisissons cette dernière possibilité et notre scène aura pour dimensions 

finales : 2 x 2 tuiles. 

Comme nous avons fixé maintenant l'étendue finale de notre scène, nous pouvons calculer les 

nouvelles coordonnées UTM en bas à droite (X2,Y2). Cette fois, elles représenteront vraiment la 

limite inférieure droite de notre scène dans Condor. 

Nous commencerons avec notre paire de coordonnées UTM du coin supérieur gauche (X1,Y1) et 

ajouterons 23040 m pour chaque tuile dans la direction Est et soustrayons 23040 m pour chaque 

tuile dans la direction Nord. Les formules générales sont les suivantes : 

X2 = X1 + (Nb_Tuiles_Est * 23040) 

Y2 = Y1 - (Nb_Tuile_Nord * 23040) 

 

Les coordonnées UTM du coin en bas à droite pour notre scène sont alors : 

X2 = 520745 + (2 * 23040) = 566825 m 

Y2 = 5538304 - (2 * 23040) = 5492224 m 
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Nous pouvons également trouver facilement les coordonnées des deux coins restants de la scène, car 

les 4 coordonnées ci-dessus délimitent le quadrilatère rectangle exact de notre scène en 

coordonnées UTM. Les coordonnées pour notre exemple seront alors : 

Coin en haut droit : 

X3 = X2 = 566825 m 

Y3 = Y1 = 5538304 m 

Coin en bas gauche : 

X4 = X1 = 520745 m 

Y4 = Y2 = 5492224 m 

Notez les coordonnées des quatre coins, car elles seront utilisées plus tard. Nous pouvons également 

les reconvertir en latitude/longitude en degrés décimaux en utilisant le même outil que nous avons 

utilisé auparavant. Les coordonnées de latitude/longitude décimales seront ensuite utilisées pour 

calibrer le terrain. 

Utiliser "UTMtools" 
L'autre manière de calculer les coordonnées UTM du coin en bas à droite utilise l'application 

"UTMtools". Cette manière est très simple, car, tout ce que vous devez faire, c'est d'entrer les 

coordonnées de latitude et de longitude décimales des points limites de notre zone d'intérêt dans 

l'application et le reste des calculs est fait automatiquement. Si les dimensions de la scène ne sont 

pas des multiples entiers de la taille d'une tuile, "UTMtools" suggérera l'extension vers une plus 

grande scène, la plus proche, avec des dimensions entières de tuiles par défaut. La taille de la scène 

en nombre de tuiles pourra encore être ajustée par la suite. 

"UTMtools" calcule également automatiquement les coordonnées des 4 coins de la scène utilisés 

pour la calibration de la scène et ils peuvent être également sauvegardés dans 

"CalibrationPoints.csv" afin qu'ils puissent être utilisés pour étalonner à nouveau votre scène dans 

"Landscape Editor", si nécessaire. 

Notez les valeurs "TL easting "(Est), "TL northing "(Nord), "BR easting" (Est) et "BR northing" (Nord), 

ou gardez l'application "UTMtools" ouverte. 
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Figure 2 - "UTMtools" 

Comme nous avons calculé les coordonnées des limites de notre scène, nous pouvons maintenant 

passer au téléchargement des données d'élévation du terrain à partir d'une source de données 

sélectionnée. 

Obtenir les données d'élévation du terrain 
Il existe plusieurs sources pour les données d'élévation numériques. Dans notre exemple, nous 

utiliserons des données d'une seconde d'arc (1") provenant du service "Earth Explorer" géré par 

"l'United States Geological Survey" (USGS). "Earth Explorer" se trouve à : 

 https://earthex50plorer.usgs.gov/. 

Pour télécharger les données, vous devez d'abord vous inscrire et créer votre compte utilisateur. 

L'inscription est gratuite. 

Après l'enregistrement, nous pouvons procéder à la sélection de la zone pour laquelle nous voulons 

obtenir les données. Nous pouvons le faire en sélectionnant la zone sur la carte ou en entrant les 

coordonnées de la zone. Comme nous avons calculé les coordonnées des quatre points d'étalonnage 

à l'étape précédente, nous pouvons maintenant les utiliser pour spécifier la zone pour laquelle nous 

voulons télécharger les données. 

Maintenant, il est également temps d'envisager une extension de la zone en ajoutant une marge sur 

chaque bordure, car une distorsion survient lors de la projection des données WGS 84 de 1" en UTM 

et la zone initialement prévue peut être insuffisante. 

Essayez de visualiser ou dessiner la position de votre scène dans une grille latitude/longitude. Elle est 

située quelque part dans une zone presque carrée ou rectangle bordée de parallèles et de méridiens. 

Si l'une des bordures de la zone de la scène est très proche d'un parallèle ou d'un méridien 

limitrophe, vous devrez envisager d'ajouter une marge dans cette direction pour inclure plus de 

terrain. Si la bordure de la scène est suffisamment éloignée d'un parallèle ou méridien limitrophe, 

aucune marge n'est nécessaire.  

https://earthexplorer.usgs.gov/
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Comme les données SRTM sont fournies sous la forme d'une tuile d'un degré en longitude et latitude 

et qu'une tuile entière doit être importée même si seule une toute petite partie de votre scène se 

trouve dans la tuile particulière, le chevauchement sur un parallèle ou un méridien ajoutera toute la 

zone supplémentaire de 1 degré du terrain environnant.  

 

Figure 3 - Site Web de USGS "Earth Explorer" 

Il n'y a pas de formule exacte pour estimer la valeur de cette marge. La règle empirique pour 

l'estimation est : plus grande est la zone de votre scène, plus la marge doit être importante. Essayez 

d'expérimenter avec une valeur empirique. Si la marge s'avère trop petite, augmentez-la et 

téléchargez à nouveau les données. Comme les dimensions en degrés de la scène dans notre 

exemple sont d'environ 0.635 x 0.417, nous ajouterons seulement une zone de marge de 0.25 degré. 

Une marge de 0.5 degré devrait suffire pour de grandes surfaces. 

L'image suivante contient une visualisation de notre zone de scène dans la grille latitude/longitude. 

Comme nous pouvons le voir, les limites supérieures et à droite de notre scène sont très proches du 

50ème parallèle et du 16ème méridien respectivement. L'ajout d'une marge en haut et à droite 

assurera que les trois tuiles voisines fourniront suffisamment de «tampons» de terrain pour que le 

traitement s'effectue sans manque. 
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Figure 4 -Croquis de la scène reportée sur la grille parallèle/méridien, incluant la zone tampon (rose) 

Le tableau ci-dessous contient toutes les coordonnées d'origine et les nouvelles coordonnées avec 

les marges incluses. Nous avons ajouté une marge à tous les côtés de la scène. Cependant, comme 

vous pouvez le voir, l'ajout de la marge à gauche et au bas de la zone ne change rien - même avec la 

marge supplémentaire, cette partie de la zone est toujours bien à l'intérieur de la tuile N49E15. 

  
Latitude Longitude 

Latitude avec 

marge 

Longitude avec 

marge 

Haut gauche 49.9967 15.2894 50.2467 15.0394 

Haut droit 49.9933 15.9323 50.2433 16.1823 

Bas droit 49.5789 15.9243 49.3289 16.1743 

Bas gauche 49.5822 15.2869 49.3322 15.0369 

Toutes les valeurs doivent utiliser le point (.) comme séparateur décimal et non la virgule (,) 
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Figure 5 - Zone recherchée dans "Earth Explorer" 

Maintenant que nous avons les coordonnées de la 

zone, nous pouvons les entrer dans "Earth 

Explorer". Passez en degrés décimaux dans la 

section "Coordinates" (Coordonnées) de l'onglet 

"Search Criteria" (Critères de recherche) et 

commencez manuellement à ajouter les 

coordonnées avec marge se trouvant dans le 

tableau ci-dessus. Appuyez sur le bouton "Add 

Coordinate" (Ajouter des coordonnées). 

Commencez par la paire de coordonnées en haut à 

gauche et continuez dans le sens des aiguilles d'une 

montre avec les autres. 

Maintenant que nous avons défini la zone nous 

intéressant, nous pouvons procéder à l'obtention des données. Appuyez sur le bouton "Data 

Sets >>", dans la liste de la page suivante, sélectionnez "Digital Elevation> SRTM> SRTM 1 Arc-

Second Global" et enfin appuyez sur le bouton "Results >>". 

Comme nous l'avons déjà mentionné, les données SRTM sont fournies sous forme de tuiles de 1 x 1 

degré. Comme notre scène avec marge chevauche le 16e méridien et le 50e parallèle Nord, nous 

avons besoin de 4 tuiles au total. 

Figure 6 - Sélection des données SRTM de 1" d'arc 
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REMARQUE : La liste des résultats ne peut afficher plus de 10 pages 

à la fois, chacune contenant 10 tuiles, c'est-à-dire jusqu'à 100 tuiles 

SRTM au total. Si votre scène est très grande, certaines tuiles 

peuvent être omises. Dans ce cas, téléchargez les tuiles en deux 

étapes ou plus, en ne mettant en évidence qu'une partie de la zone requise à chaque étape. 

Cependant, gardez à l'esprit qu'une scène aussi vaste s'étendrait probablement sur plusieurs zones 

UTM, rendant le processus de création de scène encore plus compliqué.  

Pour télécharger les données, nous devons ajouter toutes les tuiles de la liste de téléchargement. 

Ceci est fait en cliquant sur la deuxième icône à partir de la droite. La tuile est ajoutée dans la liste, si 

l'arrière-plan de l'icône 

devient vert. Une fois que 

nous avons sélectionné 

toutes les tuiles dont nous 

avons besoin, nous pouvons 

cliquer sur le bouton "View 

Item Basket >>" (Afficher le 

panier d'articles). Cela nous 

amène à la liste de 

téléchargement groupée 

contenant les éléments que 

nous avons précédemment 

sélectionnés. Là, nous 

cliquons sur la liste "SRTM 1 

Arc-Second Global" et 

vérifions si tous les fichiers 

ont "BIL 1 Arc-second" 

sélectionnés comme produit 

associé. Si c'est le cas, nous 

pouvons cliquer sur le 

bouton "Proceed to 

Checkout >>" (Passer à la caisse). 

Dans le "Checkout form" (Formulaire de paiement), vérifiez si le nombre de produits correspond au 

nombre de tuiles requis. Si c'est le cas, appuyez sur le bouton "Submit Order Button" (Envoyer la 

commande). Ne vous inquiétez pas, bien que toute l'interface ressemble à un "E-shop", vous ne 

serez pas facturé, car les données que vous téléchargez sont fournies gratuitement. 

Après avoir envoyé la commande, il vous sera demandé de télécharger et d'installer l'application 

"Bulk Download Application" (BDA), qui sera utilisée pour télécharger toutes les tuiles du serveur 

"Earth Explorer". Vous avez besoin de le faire qu'une seule fois. Une fois le BDA installé, vous pouvez 

l'utiliser pour tout téléchargement ultérieur depuis "Earth Explorer". 

Lorsque vous exécutez le BDA, il vous demandera vos informations de connexion à "Earth Explorer". 

Une fois connecté, il affichera la liste des commandes groupées actives pouvant être téléchargées. Si 

vous n'avez pas passé plusieurs commandes, il ne doit y avoir qu'un seul ordre actif dans la liste. 

Sélectionnez-le et vous devriez voir son contenu. 

Figure 7 - Tuiles sélectionnées pour le téléchargement 
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Figure 8 - Interface utilisateur du "Bulk Download Application" 

Vous pouvez changer le dossier de destination en cliquant sur l'icône du dossier dans le coin 

supérieur droit de la fenêtre. Appuyez sur le bouton "Begin Download" (Commencer le 

téléchargement) pour commencer à télécharger les fichiers. Une fois le téléchargement terminé, le 

BDA peut être fermé. 

Nous avons alors tous les fichiers dont nous avons besoin, mais pour obtenir les données de terrain 

brutes finales à importer dans Condor, nous devons d'abord traiter les données téléchargées dans un 

logiciel SIG (Système d'Information Géographique, en anglais l'acronyme est GIS "Geographical 

Information System"). 

Traitement des données d'élévation dans "QGIS" 
Comme nous essayons d'utiliser autant de produits logiciels libres et open source que possible, nous 

utiliserons le Système d'Information Géographique open source "QGIS" pour notre exemple. Si vous 

ne l'avez pas encore téléchargé et installé, c'est le moment de le faire. Il est disponible à 

http://www.qgis.org. L'interface en français est téléchargée d'office. 

REMARQUE: "QGIS" n'est pas le seul logiciel utilisable pour cette étape. Tant que vous pouvez 

effectuer des opérations similaires et obtenir le même résultat que l'utilisation de "QGIS", vous 

pouvez utiliser n'importe quel logiciel SIG avec lequel vous êtes qualifié. 

Tout d'abord, nous devons décompresser les tuiles téléchargées dans un dossier. Il est recommandé 

d'utiliser le même dossier pour toutes les tuiles, car cela facilitera leur sélection dans "QGIS". 

http://www.qgis.org/
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Après avoir décompressé les données, nous pouvons démarrer "QGIS Desktop" et commencer leur 

traitement. La première étape consiste à fusionner toutes les tuiles de données séparées en un seul 

grand modèle d'élévation. Dans le menu principal de "QGIS", sélectionnez "Raster > Divers > 

Fusionner..." pour ouvrir la fenêtre de fonction "Fusionner". 

Dans la fenêtre "Fusionner", cliquez sur le bouton "Sélectionner..." à côté de la zone d'édition 

"Fichiers Sources". Dans la boîte de dialogue de sélection de fichiers, naviguez jusqu'au dossier avec 

nos tuiles décompressées. Vous verrez beaucoup de fichiers lorsque vous ouvrez le dossier, mais un 

seul type de fichier nous intéresse. Dans le filtre de type de fichier, sélectionnez "ESRI .hdr Labeled (* 

.bil * .BIL)" pour afficher uniquement les fichiers de données d'élévation. Vous devriez maintenant 

voir quatre fichiers. Sélectionnez-les tous et cliquez sur "Ouvrir". 

 

Figure 9 - Sélection des fichiers à fusionner 

Les noms de tous les fichiers sélectionnés doivent désormais être visibles dans la zone d'Édition 

Fichiers d'entrée. Maintenant, cliquez sur le second bouton "Sélectionner..." pour spécifier le fichier 

de sortie. Définissez "ESRI .hdr Labelled" comme type de fichier de sortie et entrez un nom de votre 

choix. Nous allons utiliser "tutorial_merged.bil" dans notre exemple. 

Lorsque vous êtes de nouveau dans la fenêtre "Fusionner", cliquez sur "OK" pour terminer le 

processus. 

"QGIS" travaillera pendant un moment et vous informera lorsque le processus sera terminé. Vous 

pouvez ensuite fermer la fenêtre "Fusionner". Vous avez probablement remarqué que notre terrain 

fusionné est maintenant affiché dans la fenêtre principale de "QGIS" et la fenêtre de la liste des 

couches contient une couche avec le même nom que notre fichier de sortie. 

Le terrain tel qu'il est affiché est projeté dans le système de coordonnées WGS84, mais nous devons 

le projeter dans la bonne zone UTM. 
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Figure 10 - "QGIS" avec le terrain chargé 

Dans le menu principal, sélectionnez "Raster> Projections > 

Projection...." Lorsque la fenêtre "Projection" apparaît, 

notez que notre fichier "tutorial_merged.bil" est 

sélectionné comme fichier d'entrée - nous appliquons la 

fonction au calque sélectionné. 

Cliquez sur "Sélectionner..." pour spécifier le fichier de 

sortie. Comme dans les étapes précédentes, utilisez le type 

de fichier "ESRI .hdr Labelled" et entrez le nom du fichier. 

Nous allons utiliser "tutorial_warped.bil" dans notre 

exemple. 

Cochez la case "SCR Cible", puis cliquez sur "Selection ..." à 

côté pour choisir le système de coordonnées cibles pour le 

processus de projection. Nous utiliserons la projection 

"UTM" avec le datum WGS 84". Nous savons, d'après nos 

calculs, que notre scène est située dans la zone UTM 33N, 

donc nous devons trouver le système de référence de coordonnées de la zone "33N WGS 84/UTM" 

dans la liste. Heureusement, la boîte de dialogue de sélection "Select the target SRS" offre un filtre 

de recherche qui peut affiner la liste. Entrez "wgs 84 utm 33n" comme valeur de filtre. La liste des 

systèmes de référence ne devrait contenir que le système de coordonnées dont nous avons besoin. 

Sélectionnez le système de coordonnées requis et cliquez sur "OK" pour fermer la boîte de dialogue 

et revenir à la fenêtre de "Projection". Cochez la case "Méthode d'échantillonnage" et sélectionnez 

"Cubic Spline" dans la liste déroulante. 

Pour la dernière étape, cliquez sur l'icône en forme de crayon pour éditer les paramètres de la 

fonction de projection. Ajouter "-tr 30 30" après "EHdr". De cette façon, nous spécifions la résolution 

du terrain de sortie, ce qui est très important. Sinon, nous pourrions nous retrouver avec un fichier 

de données inutile de plusieurs dizaines ou centaines de giga-octets. Ne cliquez plus sur l'icône du 

Figure 11 - Sélection du SCR cible 
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crayon, cela supprimerait tous les paramètres ajoutés 

manuellement ! Cliquez sur "OK" pour commencer la 

projection en UTM. 

Comme vous l'avez peut-être remarqué, le terrain affiché 

a un peu changé. Cependant, ce que nous voyons 

maintenant est le terrain projeté rendu dans le système 

de référence original WGS 84. L'opération précédente a  

enveloppé les données "Raster" pour les rendre 

manipulables comme des données vectorielles. Cliquez 

sur l'icône du système de référence de coordonnées 

dans le coin inférieur droit de la fenêtre "QGIS" et 

sélectionnez "WGS 84/UTM zone 33N" comme système 

de coordonnées. Comme nous l'avons déjà utilisé, nous 

n'aurons plus besoin de le rechercher, car il sera proposé 

dans la liste des systèmes précédemment utilisés.  

 

 

Figure 13 - - Indicateur du système de référence 

 

 

Figure 14 - Choix du système de référence 

Figure 12 - La fonction de "Projection" avant 
exécution 
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Cliquez sur "OK" et les proportions du terrain sont maintenant totalement différentes. 

Nous arrivons maintenant la dernière étape. Pour faciliter l'importation de données de terrain dans 

Condor, nous pouvons supprimer les parties inutiles du terrain et ne conserver que la partie 

nécessaire pour notre scène. 

À partir du menu principal de "QGIS", sélectionnez "Raster > Extraction > Découper". Sélectionnez le 

fichier source "tutorial_warped" dans la liste déroulante. Cliquez sur "Sélectionner..." pour spécifier 

le fichier de sortie. Sélectionnez le fichier "ESRI .hdr labelled" comme type de fichier et entrez un 

nom de fichier. Nous allons utiliser "tutorial_clipped.bil" dans notre exemple. 

Le "Mode de découpage" doit être réglé sur "Emprise". Pour ce mode, nous devons entrer à l'Est et 

au Nord des coins supérieurs gauches et inférieurs droits en mètres. Utilisez les valeurs que vous 

avez notées précédemment ou si vous utilisez "UTMtools", vous pouvez copier les valeurs 

directement à partir du diagramme de scène en double-cliquant sur la valeur requise. 

Lorsque les deux paires de coordonnées sont entrées, la zone qu'elles déterminent est mise en 

surbrillance rouge dans la fenêtre du terrain. 

Cliquez sur l'icône en forme de crayon et spécifiez à nouveau la résolution du terrain en ajoutant : 

"- tr 30 30", après "EHdr" dans les paramètres de la fonction. Cliquez sur "OK" pour procéder au 

découpage. Une fois de plus, "QGIS" vous avertira lorsque le processus sera terminé et vous pourrez 

Figure 15 - La fonction de découpage avec la zone correspondante en surbrillance 
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ensuite fermer la fenêtre "Découper". Le fichier créé à l'aide de "Découper" est maintenant prêt à 

être importé dans Condor. 

Comme nous n'aurons pas besoin de "QGIS" pour les prochaines étapes, enregistrez le projet avec 

nos couches de terrain et fermez "QGIS". 

Importation des données d'élévation du terrain dans Condor 
Dans cette étape, nous utiliserons l'application "RawToTrn", qui fait partie du "Condor Landscape 

Toolkit", pour traiter les données d'élévation brutes exportées depuis "QGIS", puis exporter le terrain 

au format du terrain de Condor. "RawToTrn" s'ouvre normalement sur l'onglet "Load" (Charger). 

Avant de charger les données dans "RawToTrn", nous devons retrouver les deux paramètres requis 

pour l'importation. Accédez au dossier dans lequel nous avons enregistré nos fichiers "bil" traités 

avec "QGIS". Chaque fichier "bil" est associé à un fichier "hdr" d'en-tête décrivant la structure des 

données qui y sont stockées. Trouvez le fichier "tutorial_clipped.hdr" et ouvrez-le dans n'importe 

quel éditeur de texte, par ex. le Bloc-notes. 

Pour que les données brutes soient importées 

correctement, nous avons besoin des valeurs de 

NROWS et NCOLS. Dans le cas de notre exemple, les 

deux valeurs sont égales à 1536. 

Les valeurs NROWS et NCOLS sont en réalité liées à la 

taille de notre scène en tuiles. Nous savons que la 

taille des tuiles est de 23040 mètres et que le 

maillage des données d'élévation est égal à un carré 

de 30 x 30 mètres. À partir de là, nous pouvons 

déduire que nous avons besoin d'un tableau de 768 x 

768 carrés pour stocker les données d'élévation 

d'une tuile (192 x 192 carrés pour une tuilette, ou 

"patch"). Les valeurs stockées dans le fichier hdr 

correspondent donc à la taille des tuiles de notre 

scène du didacticiel, qui est de : 2 x 2 (768 x 2 = 

1536). 

Si et seulement si NROWS et NCOLS sont des multiples entiers de 192, les données de terrain 

peuvent être directement exportées vers Condor sans aucun recadrage supplémentaire dans l'outil 

"RawToTrn". Lorsque vous travaillez sur une scène ne comprenant que des tuiles entières, NROWS et 

NCOLS doivent être aussi des multiples entiers de 768. 

Exécutez l'outil "RawToTrn" et entrez la valeur NCOLS en tant que largeur et la valeur NROWS en tant 

que hauteur. Vérifiez que "Flip vertical" est coché. Comme la résolution de nos données est de 1 

seconde d'arc, assurez-vous que l'option "SRTM 30 m" est également cochée. Une fois que tout est 

configuré, nous pouvons cliquer sur le bouton "Load raw heightmap" et sélectionner notre fichier de 

données "tutorial_clipped.bil". 

Figure 16 - Contenu du fichier HDR 
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Après avoir chargé les données de terrain brutes, vérifiez si la taille de la scène est bien proche d'un 

multiple de 23.04 kilomètres et la taille en carrés est bien un multiple de 768. 

Si la taille du terrain n'est pas correcte, passez à l'onglet "Crop" (Recadrer) et ajustez la taille de la 

scène pour répondre à ces exigences. 

Le recadrage avec l'option "Border Crop" cochée vous permet d'enlever du terrain de la scène par 

incrément d'un rang ou d'une colonne correspondant à une largeur de tuilette (5,76 km), sur les 4 

bordures. 

En cochant "Exact Crop", un recadrage plus précis des données source au niveau du carré (30 x 30 m) 

peut être effectué en spécifiant les coordonnées du carré en haut à gauche et la largeur et la hauteur 

du carré de la zone du terrain. 

REMARQUE: Bien que nous puissions également ajuster la taille du terrain dans l'outil "RawToTrn", 

il est plus aisé de préparer des données de terrain de taille correcte pendant leur traitement dans 

"QGIS". Non seulement nous évitons de recadrer le terrain, mais tout le processus d'étalonnage du 

terrain décrit plus tard sera plus facile. 

Comme nous avons préparé et recadré les données dans "QGIS", nous n'avons pas besoin de faire de  

recadrage de la scène dans "RawToTrn" et nous sommes prêts à sauvegarder le terrain dans le 

format des scènes Condor. Cependant, avant de faire cela, nous devons aller vers le dossier 

"Condor2\Landscapes" et créer la structure de dossier nécessaire pour notre scène. D'abord, nous 

créons le dossier "Condor2\Landscapes\Tutorial", qui est le dossier racine de toute notre scène. 

Comme deuxième étape, nous devons créer le dossier "HeightMaps" (Carte des Hauteurs) dans 

notre dossier racine de scène, c'est-à-dire "Condor2\Landscapes\Tutorial\HeightMaps". 
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Maintenant, nous pouvons passer à l'onglet "Save" (Enregistrer) et remplir les informations 

d'étalonnage. D'abord, nous devons sélectionner la zone UTM où se trouve la scène (ou la zone de 

référence, si elle s'étend sur plusieurs zones). Ensuite, nous sélectionnons le coin, qui sera utilisé 

pour l'étalonnage. Nous allons utiliser le coin supérieur gauche. Comme dernière étape, nous devons 

remplir les coordonnées "UTM easting" et "UTM northing" du coin sélectionné. 

Cliquez sur le bouton "Save to TRN" pour ouvrir la boîte de dialogue d'enregistrement du fichier de 

terrain. Accédez à la racine de notre exemple de scène et entrez le même nom de fichier que le nom 

de la scène, c'est-à-dire "Tutorial.trn". Cliquez sur "Save" (Enregistrer) et le terrain de la scène pour 

Condor2 est créé. Maintenant, vous pouvez fermer "RawToTrn", car il ne sera plus nécessaire pour ce 

tutoriel. 

Nous avons téléchargé et traité avec succès des données d'élévation brutes à l'aide de "QGIS" et les 

avons converties au format de terrain Condor à l'aide de l'outil "RawToTrn". Cependant, notre scène 

est encore incomplète et ne peut pas encore être testée avec Condor. 
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5. Structurer la scène 
Dans ce chapitre, nous discutons de toutes les étapes nécessaires pour préparer notre scène pour le 

premier vol d'essai dans Condor 2. 

Nous avons terminé le chapitre précédent en créant les dossiers nécessaires pour notre scène et en 

exportant le terrain au format terrain Condor. Maintenant, nous pouvons commencer à l'éditer dans 

" CLT Landscape Editor ". 

Après avoir démarré "Landscape Editor", sélectionnez notre scène "Tutorial" dans la liste déroulante 

"Landscape". Notre terrain sera chargé et affiché dans l'éditeur. 

La "View/Modify tool box" (boîte à outils Afficher/Modifier) dans la partie gauche de l'éditeur 

contient plusieurs fonctions avec des cases à cocher. La case cochée d'une fonction signifie que les 

données relatives à la fonction seront visibles dans la vue du terrain. Plusieurs cases à cocher 

peuvent être cochées en même temps. Pour activer une fonction, cliquez dessus pour la mettre en 

surbrillance. Une seule fonction est active à un moment donné. 

Puisque nous avons calibré notre terrain en utilisant "RawToTrn", nous n'avons pas besoin de le faire 

à nouveau dans "Landscape Editor". Si vous souhaitez effectuer un calibrage manuel du terrain, 

reportez-vous à l'Annexe 1. 

Maintenant, c'est le bon moment pour sauvegarder le terrain - dans le menu principal, sélectionnez 

"File > Save Landscape" (Fichier > Enregistrer la scène). Notre terrain est maintenant prêt, et nous ne 

sommes plus qu'à quelques pas de l'expérimenter dans Condor 2. 

Pour tester notre scène, nous devons d'abord ajouter au moins un aéroport. À ce stade, l'aéroport 

sera purement "virtuel", car il n'y aura pas de modèle 3D placé dans la scène. Cependant, les 

données d'aéroport définies dans "Landscape Editor" (l'éditeur de scène) nous permettront de 

commencer à voler dans les airs au-dessus de la position de l'aéroport. 

Mettez en surbrillance "Airports" (Aéroports) dans la boîte à outils pour activer 

cette fonction et cochez la case en regard pour afficher les aéroports dans la 

fenêtre du terrain. Ensuite, faites un clic droit sur "Airport list" (Liste des 

aéroports) vide sous la boîte à outils et sélectionnez "Add" (Ajouter) dans le menu 

contextuel. 

Remplissez toutes les données comme dans l'image ci-dessus et cliquez sur "OK". 

Vous devriez maintenant voir l'aéroport de Podhořany ("Podhorany" est le nom 

de l'aéroport dans Condor2) au milieu de la scène. Nous l'utiliserons pour notre 

test. Comme l'aéroport est situé près de la crête de la Montagnes de Fer, vous 

pouvez même tenter un vol de pente lors de votre premier vol d'essai. N'oubliez 

pas que l'aéroport est actuellement seulement "virtuel". Il n'y a pas de piste et le 

terrain n'est pas aplani pour les décollages par "winch" (treuil) ou "tow" 

(remorquage ). Utiliser le départ "airborne" (en vol) jusqu'à l'ajout des aéroports 

(dans le chapitre 5). 

Maintenant, nous allons réaliser les dernières étapes restantes nécessaires pour 

tester la scène dans Condor. En bref, nous devons exécuter les quatre fonctions 

d'exportation dans le menu "File" (Fichier). Nous en discuterons de manière 

détaillée dans le chapitre suivant. Figure 17 - Données pour un 
aéroport 
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Sélectionnez d'abord "File > Export flightplanner map" (Fichier > Exporter la carte du plan de vol). 

Cela générera une carte de notre scène qui sera utilisée dans le planificateur de vol de Condor. 

Ensuite, sélectionnez "File > Export forest map" (Fichier > Exporter la carte des forêts). Nous n'avons 

pas encore créé de tuiles de carte des forêts, donc nous n'aurons pas d'arbres dans notre scène, mais 

la carte de forêt exportée est nécessaire, même si elle est vide maintenant. Cliquez sur "Yes" (Oui), 

puis sur "No" (Non) pour exporter la carte de forêt. 

Sélectionnez "File > Export Thermal Map" (Fichier > Exporter la carte thermique). Cela permettra 

d'exporter la carte thermique qui indique au moteur météo de Condor dans quelles zones de la scène 

se trouve la plus forte probabilité de présence de thermiques. Encore une fois, nous n'avons pas 

encore préparé de carte thermique, donc la carte thermique exportée n'influencera pas réellement 

la production de thermiques. 

Puis, sélectionnez "File > Export textures to DDS" (Fichier > Exporter les textures vers DDS). Pour que 

ce processus fonctionne, nous devons avoir mis le fichier "nvdxt.exe", provenant des outils de 

texture hérités de Nvidia, dans le même dossier que "LandscapeEditor.exe". Cliquez sur "Yes" (Oui) 

pour confirmer que le processus peut prendre un certain temps, puis sur "No" (Non) pour créer 

toutes les textures. Notre scène sera recouverte de textures grises générées à partir des 

caractéristiques du terrain. Ne vous inquiétez pas, nous les remplacerons dans le prochain chapitre.  

Enfin, vous devez générer les "hash files" (fichiers de vérification) pour les tuilettes de terrain et de 

forêt. Ces fichiers (Nom_de_la_Scene.THA et Nom_de_la_Scene.FHA) sont très importants pour la 

protection anti-triche pendant les vols multijoueurs. Aussi, s'ils ne sont pas présents, votre scène ne 

sera pas utilisable dans Condor. Sélectionnez "File > Export terrain hash" (Fichier > Exporter le fichier 

de vérification du terrain), puis "File > Export Forest hash" (Fichier > Exporter le fichier de 

vérification de la forêt). 

 

 

Il est très important de générer des fichiers de vérification chaque fois que le 
terrain ou les cartes forestières sont modifiés, car Condor signalera la 
manipulation de la scène en mode solo et en mode multijoueur en compétition, si 
les fichiers de vérification sont différents des tables originales de vérification.  

 
 
 
 
 
 

 

De nouvelles fonctionnalités anti-triche ont été introduites en V2, liées aux 
changements de l'architecture de la scène en V2. Toutes les tuilettes de carte de 
terrain/forêt sont maintenant vérifiées par rapport à la table de vérification 
lorsqu'ils sont chargés dans le jeu et si une différence est trouvée, cela est 
considéré comme une tentative de triche.  
Dans les vols multijoueurs, les tables de vérification sont comparées à la table de 
vérification du serveur d'hébergement pour s'assurer que tous les pilotes en 
compétition ont les mêmes données de terrain et de forêt.  
 
Si nécessaire, les tables de vérification du terrain et de forêt peuvent être créées à 
partir de la ligne de commande en appelant : 
"LandscapeEditor.exe -hash LandscapeName". 
Par exemple : "LandscapeEditor.exe -hash Tutorial" 
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Vous pouvez maintenant enregistrer à nouveau votre scène en utilisant "File > Save Landscape" 

(Fichier > Enregistrer la scène), fermez "Landscape Editor" et lancez Condor pour profiter du premier 

vol sur votre propre scène Toutes nos félicitations !  

 

Fichier de paramètres de scène - LandscapeName.ini 
Le dossier racine de la scène peut contenir un fichier .ini avec quelques informations 

supplémentaires. Actuellement, il existe deux paramètres qui peuvent être spécifiés dans celui-ci. 

Le fichier .ini contient une section appelée "General", qui inclut les paramètres suivants : 

• "Version" - numéro de version de la scène. Il est affiché à la fois dans le planificateur de vol 

et dans la liste des serveurs sur le site Web de Condor. Le numéro de version permet une 

identification plus facile de la scène nécessaire pour effectuer le vol. 

• "RealtimeShading" - paramètre spécial qui peut être utilisé pour désactiver l'ombrage de 

terrain en temps réel des scènes de texture "photo". Ce paramètre est facultatif, l'ombrage 

est activé par défaut. Pour désactiver l'ombrage, utilisez "RealtimeShading = 0". 

Exemple de contenu du fichier .ini de la scène est ci-dessous. La scène dans ce cas est en version 0.9 

et le terrain sera ombragé en temps réel. 

[General] 

Version = 0.9 

RealtimeShading = 1 
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6. Ajout de textures personnalisées à notre scène 
Le chapitre précédent s'est conclu avec le premier vol d'essai sur notre scène "Tutorial". Cependant, 

la scène est recouverte d'une texture grise uniforme et elle est vide de tout détail. 

Dans ce chapitre, nous discuterons de l'ajout de textures personnalisées à notre scène. Nous allons 

également décrire comment ajouter des plans d'eau avec des effets réalistes et des arbres générés 

automatiquement. 

Tous les fichiers "sources" utilisés lors du développement de notre scène sont stockés dans le dossier 

de travail de notre scène, c'est-à-dire "Landscapes\Tutorial\Working". Nous référencerons ce dossier 

simplement comme "Dossier de travail" plus loin dans le texte. Ce dossier est seulement nécessaire 

pendant le développement, il n'est pas nécessaire pour que la scène finale fonctionne, et il devra 

donc être enlevé lors de la distribution, à moins que vous vouliez donner à chacun l'accès à tous vos 

dossiers et fichiers sources. 

Comme mentionné plusieurs fois précédemment, pour le traitement dans "Landscape Editor", les 

scènes de Condor 2 sont divisées en tuiles carrées de 23,04 x 23,04 km. Chaque tuile a exactement 

un fichier de texture de tuile lui correspondant. Le nom de fichier de ce fichier est le même que celui 

de la tuile, c'est-à-dire que le fichier de texture 0503.bmp appartient à la tuile de terrain 0503. Les 

textures sont stockées au format Windows Bitmap (BMP). Toutes les textures de tuiles sont stockées 

dans le sous-dossier "Terragen\Textures" créé automatiquement dans notre dossier de travail, c'est-

à-dire "Landscapes\Tutorial\Working\Terragen\Textures". La résolution standard des textures des 

tuiles dans Condor 2 est de 8192 x 8192 pixels, donnant une résolution de la texture d'environ 

2,8x2.8 m par pixel sur le terrain. 

REMARQUE: Sachez qu'une texture de tuile dans la résolution 8192 enregistrée au format ".bmp" 

nécessite près de 200 mégaoctets d'espace disque. L'espace requis pour les textures et les cartes 

sources pour une scène plus grande peut facilement atteindre plusieurs giga-octets. 

Il existe deux approches principales pour créer des textures de scène : 

1. Les textures graphiques "synthétiques" - toutes les textures sont créées manuellement, 

entièrement ou partiellement. Nous utiliserons cette approche dans notre tutoriel, mais de 

manière très simple, car il est très facile de passer des dizaines d'heures de travail sur une 

texture pour une seule tuile. La scène par défaut de Slovénie V2 ou l'une des scènes de 

CondorWorld, toutes créées par le créateur de scène expérimenté Miloš Koch, est l'exemple 

parfait de l'utilisation de textures graphiques synthétiques. 

2. Les textures "photoréalistes" - l'ensemble de la scène est couverte par des textures faites à 

partir d'images aériennes/satellites de la zone particulière. Le plus grand avantage de cette 

approche est que la scène ressemble exactement à la scène réelle au moment de la prise de 

vue. Cependant, il existe plusieurs inconvénients distincts. De telles photos sont 

généralement prises pendant une période plus longue, entraînant un éclairage et des 

couleurs discordantes. De plus, tous les reliefs et tous les objets du terrain projettent des 

ombres qui sont enregistrées sur les images. Comme Condor 2 apporte un éclairage réaliste 

et l'ombrage du terrain et des objets, aucun ombrage du terrain n'est nécessaire et c'est 

même contre-productif. Une autre question qui doit être prise en compte réside dans le fait 

que l'imagerie aérienne/satellite fait l'objet d'une licence, et sa réutilisation est strictement 

limitée, même si le téléchargement est autorisé pour tous. Par exemple. Google Maps a des 
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conditions de licence très strictes interdisant la réutilisation, la redistribution et même le 

téléchargement en masse de leurs données. 

Créer des textures pour notre scène 
Il est important de souligner que la création de textures n'est pas l'objectif principal de notre tutoriel 

de scène, mais qu'une scène sans textures serait incomplète. 

Si vous avez déjà créé des textures pour V1, vous pouvez simplement passer au sous-chapitre 

"Ajouter des effets sur l'eau", car les plans d'eau font l'objet de nouvelles fonctionnalités dans 

Condor 2. 

Le processus décrit ici a été conçu juste pour ce tutoriel dans le but d'être aussi rapide et automatisé 

que possible. Bien sûr, il peut être utilisé pour des scènes réelles, mais sans étapes supplémentaires 

et modifications manuelles, le résultat sera visuellement inférieur aux textures créées manuellement, 

par ex. dans la scène par défaut "Slovénia V2". 

Pour cette partie du processus, nous aurons besoin d'un logiciel de dessin bitmap (nous utiliserons le 

logiciel "Paint.NET", qui est gratuit, mais vous pouvez utiliser n'importe quel programme de dessin 

bitmap pouvant fonctionner avec des calques, par exemple "GIMP" open source ou "Adobe 

Photoshop" (payant)). Nous utiliserons également "QGIS" avec le plug-in "QuickOSM" et l'outil 

"WaterAlpha" du "Condor Landscape Toolkit". 

Premièrement, nous devons trouver les quelques textures de base que nous utiliserons pour 

construire nos textures de tuiles. En général, nous avons besoin d'une texture «terres agricoles» avec 

des bordures "seamless" (sans couture) avec des champs, mais sans aucun village, ville, plan d'eau ou 

grande forêt. Ensuite, nous avons également besoin d'une texture de forêt avec des bordures sans 

couture et une texture de la ville avec des bordures sans couture. Pour vos propres scènes, vous 

pouvez utiliser n'importe quelle texture avec une licence permettant sa réutilisation et sa distribution 

dans le cadre d'un autre travail. Pour notre tutoriel, nous utiliserons les textures de terrain gratuites 

"How in the world" (Comment dans le monde) créées par Jenna Fearon/«How in the world?» Et sous 

licence Creative Commons Attribution 4.0 International. Vous pouvez télécharger le pack de texture 

sur http://howintheworld.com/textures/. 

Nous utiliserons les textures suivantes du pack HITW au format "jpg" : 

 
HITV-TS2-French-farm-1.jpg 

Texture d'arrière-plans 

 
HITV-TS2-forest-dark-green.jpg 

Texture pour les forêts 

 
HITV-TS2-Austr-cty-farm1.jpg 

Texture pour les villages 

HITV-TS2-grass-green.jpg - Texture pour l'arrière-plan des aéroports 

http://howintheworld.com/textures/
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Toutes les forêts, zones résidentielles, plans d'eau et routes seront créés en utilisant les données du 

projet "OpenStreetMap". Nous utiliserons "QGIS" pour les récupérer. 

Lancez "QGIS Desktop" et dans le menu principal sélectionnez "Plugins > Gérer et installer les 

plugins ...." Laissez la liste des plugins disponibles se charger et une fois qu'elle est ouverte, tapez 

"quickosm" dans le champ de recherche pour trouver le plugin dont nous avons besoin, puis 

installez-le. "QuickOSM" sera ajouté au menu "Vecteur". Ouvrez le projet avec nos données de 

terrain que nous avons sauvegardées plus tôt. Nous aurons besoin de la couche "tutorial_clipped" 

pour définir l'étendue des données OSM que nous devons télécharger. 

REMARQUE: Les données OSM nécessitent beaucoup d'espace disque. Faites attention surtout si 

votre scène est assez grande. Diviser la scène et télécharger les données pour une zone plus petite 

peut aider, car vous pouvez traiter chaque partie séparément, puis supprimer les données inutiles. 

Une zone de 2x2 tuiles (la taille de notre scène "Tutorial") est un compromis raisonnable entre la 

zone de scène traitée et la taille des données nécessaires. 

Les données OSM sont étiquetées avec des clés d'attribut décrivant leur nature et leur but. Nous 

allons télécharger les données suivantes. 

landuse=forest Forest data Occupation du sol par des forêts 

landuse=farmland farm field data Occupation du sol par des champs cultivés 

landuse=residential cities, towns and villages Occupation du sol par des villes, etc.. 

landuse=reservoir ponds, polders, lakes, dams Occupation du sol par des lacs, etc.. 

waterway=* streams and rivers Occupation du sol par des fleuves, etc. 

aeroway=aerodrome airport areas Occupation du sol par des aérodromes 

 

Comme les données OSM peuvent être ajoutées par n'importe qui, il peut y avoir des problèmes 

occasionnels avec ce que vous 

voyez dans la carte OSM et ce que 

vous téléchargez et visualisez dans 

"QGIS", car les données peuvent 

avoir des attributs erronés ou non 

standard. Il est recommandé de 

comparer le résultat dans "QGIS" 

avec la carte rendue sur 

http://www.openstreetmap.org.  

Masquer tous les calques "raster" 

sauf "tutorial_clipped". 

Commençons maintenant le 

téléchargement des données 

OSM. Nous allons commencer 

avec les forêts.  

Dans le menu principal, 

sélectionnez "Vecteur > 

QuickOSM > QuickOSM" pour Figure 18 - interface "QuickOSM" 

http://www.openstreetmap.org./
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ouvrir le plugin. 

Premièrement, nous devons spécifier le couple clé/valeur des données que nous voulons télécharger. 

Nous allons commencer avec la première ligne du tableau ci-dessus. Définissez "landuse" comme clé 

et "forest" comme valeur. "QuickOSM" contient les clés les plus utilisées et leurs valeurs connexes 

qui peuvent être récupérées dans la liste déroulante, mais nous pouvons également saisir toute autre 

paire clé/valeur existante qui n'est pas directement listée. 

Maintenant, nous devons spécifier l'étendue des données. Sélectionnez le bouton radio "Étendue 

d'un calque" et sélectionnez "tutorial_clipped" dans la liste. De cette façon, nous nous assurons que 

seuls les éléments cartographiques appartenant à notre zone seront téléchargés. 

Maintenant, cliquer sur "Avancé" pour afficher les options avancées et désélectionner les cases à 

cocher "Node" (Nœuds) et "Points". Gardez toutes les autres options sélectionnées. Maintenant, 

nous pouvons cliquer sur le bouton "Exécuter". 

Une fois que la barre de progression atteint 100% et que l'information d'état "Requête réussie !" 

apparaît, nous pouvons fermer "QuickOSM" ou simplement passer à la fenêtre principale de "QGIS" 

et laisser le plugin ouvert. 

Dans la fenêtre principale, nous pouvons voir que les polygones de la forêt recouvrent maintenant le 

terrain. Leur couleur est aléatoire, et chaque polygone a un contour noir. De plus, il y a une nouvelle 

couche vectorielle appelée "landuse_forest" dans notre liste de couches contenant tous les 

polygones de la forêt. Faites un clic droit dessus et sélectionnez "Propriétés". Nous allons 

maintenant nous débarrasser du contour noir et définir la couleur des polygones à vert. 

 

Figure 19 - Paramétrages des propriétés du calque 

Dans la fenêtre Propriétés de la couche, cliquez sur l'onglet "Style" pour afficher le style de la 

couche. Cliquez ensuite sur le "Remplissage simple" pour afficher ses attributs. Une fois qu'ils 
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apparaissent, cliquez dans le rectangle de la couleur "Remplissage" pour afficher le gizmo de 

sélection de couleur et définissez la couleur à une nuance de vert. Cliquez sur la flèche en face de 

"Bordure" et choisissez "Bordure transparente" dans le menu déroulant. Cela va supprimer le 

contour noir. Cliquez sur "Appliquer" et tous les polygones doivent maintenant être verts et sans le 

contour noir. Si par hasard il y a aussi une couche de vecteur de ligne du même nom, vous pouvez la 

supprimer. 

Continuons avec les champs. Ouvrez à nouveau "QuickOSM", gardez les mêmes paramètres que 

précédemment, mais utilisez la valeur "farmland" au lieu de "forest". Nous devrions maintenant 

avoir une autre nouvelle couche vectorielle, appelée  "landuse_farmland". Enlevez son contour noir 

et mettez sa couleur à une nuance de jaune ou d'orange. S'il existe une couche de vecteur de ligne 

du même nom, supprimez-la. Contrairement aux autres couches de données, les champs ne seront 

pas utilisés pour générer des textures, mais seulement pour créer la carte thermique pour notre 

scène. 

Maintenant, téléchargeons les zones résidentielles. Ouvrez "QuickOSM" et utilisez cette fois 

"residential' comme valeur pour la clé "landuse" (utilisation des sols). Exécutez la requête et une 

autre couche devrait apparaître, appelée "landuse_residential". Encore une fois, supprimez la couche 

de vecteur de ligne du même nom si elle existe. Supprimez les contours des polygones et définissez 

leur couleur sur rouge ou similaire. 

La dernière valeur que nous allons télécharger est "reservoir". Après avoir téléchargé les polygones, 

supprimez leur contour et définissez la couleur à une nuance de bleu (notez les valeurs RVB ou la 

valeur de couleur html). Ce sera le premier de plusieurs calques contenant des informations sur l'eau. 

Ouvrez "QuickOSM" et, au lieu de "landuse"(l'utilisation des terres), utilisez la clé "waterway" (voie 

navigable). N'entrez rien en valeur. Nous voulons télécharger tous les types de polygones et de lignes 

liés à l'eau. Une fois la requête terminée, nous devrions voir le corps des rivières plus grandes comme 

des polygones et les petits ruisseaux et des rivières comme des lignes bleues. Nous devrions 

également avoir deux couches appelées "waterway" dans la liste des couches - une couche de 

polygone et une couche de ligne. Supprimez le contour des polygones et définissez leur couleur sur 

celle que nous avons utilisée pour "landuse_reservoir". Passez ensuite à la couche de ligne et utilisez 

la même couleur pour les lignes. Réglez la largeur du stylo sur env. 1,25 pixel. 

Malheureusement, comme les données "OSM" peuvent être éditées par n'importe qui, certains 

polygones du même type peuvent avoir des attributs différents des autres. C'est également le cas du 

barrage de Seč, le plus grand plan d'eau de notre scène, et de nombreux autres étangs et réservoirs, 

qui manquent encore à nos données. Pour les charger, nous devons à nouveau interroger "OSM", 

cette fois avec une clé "water" et aucune valeur. Enfin, la plupart des masses d'eau de notre scène 

sont chargées et affichées dans "QGIS" sous forme de couche de plans d'eau. Modifier ses propriétés 

pour supprimer le contour et définir la couleur à la même nuance de bleu que nous avons utilisée 

pour toutes les autres couches liées à l'eau. 

Comme les aéroports de la V2 ne contiennent aucun polygone d'arrière-plan, nous devons préparer 

les arrière-plans des aéroports dans nos textures. Nous utiliserons la clé "aeroway" avec la valeur 

"aerodrome". Nous n'obtiendrons probablement pas seulement une couche de polygone, mais aussi 

une couche de lignes. Supprimez la couche de ligne et supprimez le contour noir des polygones dans 

les propriétés de la couche de polygone. En outre, définissez la couleur de cette couche à brun ou 

similaire (utiliser une nuance qui est nettement différente de celle utilisée pour les zones 

résidentielles). 
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La dernière couche que nous allons télécharger contiendra des routes. Dans QuickOSM, utilisez la clé 

"highway" sans valeur définie. Nous devrions avoir deux couches comme dans le cas des cours d'eau. 

Définissez la couleur pour les deux à la même nuance de gris, supprimez le contour noir des 

polygones et définissez la largeur de la plume du calque des lignes à 2 pixels. 

Nous devrions maintenant avoir toutes les données dont nous avons besoin pour faire nos textures. 

Nous avons juste besoin de les exporter à partir de "QGIS" dans un format modifiable dans 

Paint.NET. Nous utiliserons la fonction "Print Composer" (Composeur d'impression) pour cela. 

Masquez le calque raster "tutorial_clipped" et appuyez sur Ctrl+P pour ouvrir le nouveau composant 

"Print Composer". Donnez éventuellement un nom, "Tutorial" par exemple. Cliquez sur l'onglet 

Composition et définissez le format de page sur "Préconfigurés > Personnalisation" et définissez la 

"Taille de la page "200 x 200 millimètres. Dans la barre d'outils de gauche, cliquez sur "Ajouter une 

nouvelle carte" et placez-la sur le canevas en cliquant et en faisant glisser. Ne vous inquiétez pas si le 

contenu semble étrange, nous allons régler cela plus tard. 

Conservez la carte sélectionnée et cliquez sur "Propriétés de l'objet". Faites défiler jusqu'à "Emprise" 

et entrez les paires de directions Est et Nord UTM gauche et droite (520745, 5492224 et 566825, 

5538304). 

Maintenant, faites à nouveau défiler un peu et cliquez sur "Position et taille" pour l'ouvrir. Réglez X 

et Y sur 0 mm et Largeur et Hauteur sur 200 mm. La carte devrait maintenant remplir tout le canevas. 

Maintenant, nous avons juste besoin de l'exporter en tant qu'image. Cliquez sur "Enregistrer en tant 

qu'image" dans la barre d'outils principale. Définissez PNG comme type de fichier et entrez un nom. 

Appelons le fichier masks.png. Dans la boîte de dialogue suivante, définissez la largeur et la hauteur 

de la page sur 16384 pixels. Comme notre scène a une surface de 2 x 2 tuiles, c'est tout ce dont nous 

avons besoin. Enregistrez l'image. Ne paniquez pas, cela prendra du temps. 

REMARQUE: Soyez prudent lors de l'exportation des masques pour une zone plus grande. Bien que le 

fichier PNG enregistré de notre exemple soit relativement petit, il prendra 1 giga-octet lorsqu'il sera 

chargé dans la mémoire ! 
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Figure 20 - Composeur d'impression, prêt pour l'exportation 

Nous avons maintenant terminé. Enregistrez le projet pour conserver les données et fermer "QGIS". 

Démarrez "Paint.NET" et ouvrez la texture "HITV-TS2-French-farm-1.jpg" des terres agricoles à partir 

du pack HITW. Sa taille est de 1024 x 1024 pixels. Parce que notre texture de tuile est de 8192 x 8192 

pixels, nous devons remplir toute cette zone avec la texture des terres agricoles. 

Sélectionnez la texture en entier et copiez-la dans le presse-papiers. Appuyez sur "Ctrl+Maj+R" pour 

ouvrir la boîte de dialogue "Taille de la zone de dessin". Définir l'ancre en bas à droite et la largeur 

de la texture à 2048 pixels. Gardez la hauteur inchangée et appuyez sur "OK". Maintenant, appuyez 

sur "Ctrl+V" pour coller la tuile du presse-papiers à la texture étendue. Elle devrait maintenant être 

remplie. Appuyez sur "Ctrl+A" pour sélectionner l'image entière, "Ctrl+C" pour la copier dans le 

presse-papiers et répétez l'extension de la texture, cette fois avec 4096 comme largeur. Collez le 

contenu du presse-papiers à l'image étendue et répétez le même processus avec une largeur de 8192 

pixels. 

Une fois la texture en tuiles de 8192 x 1024 pixels réalisée, sélectionnez-la en entier et copiez-la dans 

le presse-papiers. Encore une fois, développez le canevas, mais cette fois changez la hauteur à 2048. 

Collez l'image à une seule ligne à partir du Presse-papiers. Maintenant, sélectionnez à nouveau 

l'image entière et copiez-la dans le presse-papiers. Étendre la hauteur à 4096, coller à partir du 

presse-papiers. Maintenant, pour la dernière fois, sélectionnez l'image entière, copiez-la dans le 

presse-papiers et développez la hauteur de la texture à 8192 pixels. Maintenant, collez l'image du 

presse-papiers et enregistrez l'image finale. 

Faites la même chose avec la texture de la ville, la texture de la forêt et la texture de l'herbe de 

l'aéroport. Comme la texture de l'herbe du paquet HITW est assez sombre, éclaircissez-la un peu (ou 

utilisez une texture herbe/prairie, sans couture, différente). 

Une fois cela fait, nous devons faire exactement le contraire avec l'image de masque que nous avons 

exportée de "QGIS" - nous devons couper les tuiles. Nous allons utiliser la même fonction. 
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Ouvrir masks.png et dans "Taille de la zone de dessin" définir la largeur et la hauteur à 8192 pixels et 

l'ancrer en bas à droite. Enregistrez cette tuile en tant que 0000.png. Annuler le changement de 

"Taille" pour récupérer l'image originale et répéter la même chose avec l'ancre en haut à droite 

(0001.png), en bas à gauche (0100.png) et en haut à gauche (0101.png).  

Maintenant, nous pouvons préparer les textures finales pour nos tuiles. Chargez la texture d'arrière-

plan des tuiles de terres agricoles. Ajoutez un nouveau calque, ouvrez la texture de la forêt en tuiles, 

copiez-la dans le presse-papiers et collez-la dans le nouveau calque. Faites de même avec la texture 

de la ville en tuiles et la texture d'arrière-plan de l'aéroport. Nous devrions maintenant avoir un 

fichier avec quatre couches. 

Ensuite, ajoutez un nouveau calque et remplissez-le de couleur bleu-gris. Cette couleur sera utilisée 

pour les surfaces des plans d'eau dans nos textures. 

Ajoutez un autre calque et remplissez-le de couleur grise. Ce sera la couleur des routes. 

Enfin, ajoutez un nouveau calque et laissez-le vide. Enregistrez le fichier en tant que "template.pdn". 

Ce sera le modèle pour toutes nos textures de tuiles. 

Création et composition des textures de tuiles 
Montrons le processus de composition sur l'exemple de la tuile 0000. Chargez notre template.pdn et 

enregistrez-le sous 0000.pdn. Maintenant, copiez le masque 0000.png dans le calque vide le plus 

haut du modèle. Nous allons maintenant créer la texture finale en utilisant simplement l'outil "Magic 

Wand" (Baguette magique). 

Activez la "Baguette magique" dans la boîte à outils, réglez la "Tolérance" sur 25% et le "Mode de 

remplissage" sur "Global". Si la couche supérieure avec l'image du masque n'est pas la couche active, 

cliquez dessus dans le panneau des couches pour la sélectionner. Maintenant, cliquez sur n'importe 

quelle zone de forêt (couleur verte) dans l'image du masque. La "Baguette magique" doit 

sélectionner toute la forêt dans le masque. 

Passez maintenant à la couche contenant notre texture de forêt transparente. La sélection effectuée 

à l'aide de la "Baguette magique" est maintenant active sur cette couche. Appuyez sur Ctrl+I pour 

inverser la sélection - ceci sélectionnera toutes les zones qui ne sont pas des forêts. Appuyez sur 

"Supprimer" pour supprimer les parties sélectionnées de la texture, ne laissant que les forêts. 

Maintenant, revenez à la couche avec l'image du masque, utilisez la "Baguette magique" pour 

sélectionner toutes les zones résidentielles et passez à la couche avec la texture de la ville 

transparente. Encore une fois, inversez la sélection et supprimez les parties indésirables de la 

texture. 

Répétez maintenant le même processus sur les zones de plans d'eau (utilisez la couche bleu-gris) et 

les arrière-plans de l'aéroport (utilisez la couche de texture d'herbe). 

La dernière étape consiste à ajouter des routes. Utilisez l'outil Zoom pour zoomer sur l'une des 

routes, puis passez à la "Baguette magique" et cliquez dessus pour sélectionner toutes les routes 

dans le masque. Inversez la sélection et passez au calque tout gris. Appuyez sur "Supprimer" pour 

supprimer les parties inutiles de la texture de la route. 

Maintenant, cachez le calque d'image du masque et vérifiez l'aspect final de la texture. Enregistrez le 

fichier au format PDN, vous pouvez donc y revenir si vous avez besoin d'ajustements 

supplémentaires. Nous en aurons également besoin très prochainement pour créer des cartes des 
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forêts et des canaux alpha pour les effets de plans d'eau de cette texture. Ensuite, enregistrez à 

nouveau le fichier, cette fois au format BMP sous 0000.bmp. Ce sera la texture finale. 

Maintenant, nous devons répéter le même processus pour les trois autres  textures de tuiles 

restantes. Une fois que nous avons terminé, nous pouvons déplacer nos quatre BMP dans le dossier 

"\Terragen\Textures" dans notre dossier de travail. 

Essayons d'appliquer nos textures sur le terrain. Lancez "Landscape Editor", l'éditeur de scène, et 

ouvrez notre scène "Tutorial". Dans le menu principal, sélectionnez "Tools > Import Terragen size 

textures" (Outils > Importer les textures de taille Terragen). Nos textures seront chargées et 

affichées dans l'éditeur. Nous pouvons également réexporter le bitmap affiché dans la fenêtre du 

planificateur de vol Condor "File > Export flightplanner map" (Fichier > Exporter plan de vol). 

Si vous le souhaitez, vous pouvez maintenant exporter les textures vers DDS et essayer la scène avec 

des textures dans Condor. Nous pourrions utiliser cette fonction, cependant, puisque nous allons 

ajouter des informations sur l'eau à nos textures, ce n'est pas encore le moment d'exporter les 

textures DDS finales vers Condor. 

Ajouter des effets sur les plans d'eau 

Contrairement à V1, où chaque élément de plans d'eau était juste un point sur une texture, Condor 2 

introduit des surfaces d'eau avec des effets sur l'eau générés par des "Shaders". Pour y parvenir, 

nous avons besoin d'un moyen de dire à Condor qu'une partie donnée de la texture est supposée 

être rendue comme de l'eau avec tous ses effets. 

Pour cela, chaque texture doit avoir un canal alpha contenant des informations sur les plans d'eau. 

Malheureusement, l'ajout du canal alpha à un bitmap n'est pas un processus courant dans la plupart 

des logiciels graphiques, car le canal alpha est principalement utilisé pour encoder la transparence 

dans l'image. Les programmes graphiques calculent généralement automatiquement la valeur alpha 

et remplacent les informations de couleur du pixel d'origine par des valeurs calculées. Cela provoque 

des effets imprévisibles dans Condor. 

Nous allons utiliser l'outil "WaterAlpha" pour ajouter les informations sur l'eau à nos textures 

d'origine. Cet outil a été développé spécifiquement pour ajouter un canal alpha pour l'eau aux 

textures enregistrées en tant qu'image Windows Bitmap. Il gère également la découpe automatique 

des textures traitées en tuilettes ou "patches" et leur conversion au format DDS. 

Cependant, pour l'utiliser, nous devons d'abord créer des bitmaps de canal alpha. Nous avons 

seulement besoin de deux couleurs pour encoder l'information sur les plans d'eau - blanc pour la 

surface régulière et noir pour l'eau. Nous pouvons facilement créer de tels bitmaps à partir de nos 

fichiers sources PDN. 

 

N'utilisez jamais la fonction "Export textures to DDS" (Exporter des textures vers 
DDS) dans "Landscape Editor" (l'Éditeur de scène) pour traiter des textures 
contenant des couches alpha de l'eau. Landscape Editor utilise la compression 
DXT1 par défaut, qui produit des fichiers plus petits, mais qui n'utilise que le canal 
alpha 1bit, ce qui ne convient pas pour une représentation réaliste des plans d'eau 
(les bordures des lacs et des rivières seraient déchiquetées). 
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Commençons à nouveau avec la tuile 0000. Ouvrez le fichier 0000.pdn dans Paint.NET et masquez 

tous les calques à l'exception de celui qui contient la texture des plans d'eau. Dans le menu principal, 

sélectionnez "Ajustements > Niveau automatique". Cela va transformer la couleur bleu-gris en noir. 

Enregistrez le fichier en tant que fichier "a000.bmp". N'enregistrez aucune modification dans le 

fichier 0000.pdn d'origine. Répétez le même processus pour les trois textures restantes. 

Une fois que vous avez terminé, déplacez les quatre fichiers dans le dossier \Terragen\Textures dans 

le dossier de travail. 

Maintenant, lancez l'outil "WaterAlpha". Sélectionnez notre dossier Working\Terragen\Textures et 

définissez les dimensions de la tuile sur 8192 pixels. Cliquez sur "Process Tiles" (Traiter les tuiles). 

"WaterAlpha" commencera à traiter les textures. Il coupe d'abord les deux textures et leurs images 

alpha en tuilettes, ou "patches". Il parcourt ensuite toutes les tuilettes alpha et si une tuilette alpha 

contient des pixels noirs, elle est ajoutée à la tuilette de texture associée. Si la tuilette alpha est toute 

blanche (elle ne contient aucune information sur l'eau), elle est ignorée. Enfin, tous les correctifs sont 

convertis au format DDS avec la compression DXT en utilisant "nvDXT.exe" et stockés dans le dossier 

"\Terragen\Textures\dds\". Nous pouvons ensuite les copier ou les déplacer dans le dossier 

"Textures" de la scène", c'est-à-dire dans le dossier "Landscapes\Tutorial\Textures\", en remplaçant 

les anciens fichiers de texture. 

À moins que nous décidions de faire quelques changements dans la conception ou de corriger une 

erreur, ce seront nos textures finales du terrain. 

Ajouter des arbres 

Tout comme V1, Condor 2 utilise également des cartes de forêt pour spécifier les zones couvertes 

d'objets arborescents générés automatiquement. Cependant, la taille des tuiles de la carte des forêts 

passe à 2048 x 2048 pixels dans V2. Ceci permet un placement plus précis des zones arborées sur le 

terrain. 

Contrairement aux images alpha de l'eau, le noir dans les cartes des forêts identifie les zones sans 

couverture arborescente. Toute autre couleur indique la présence d'arbres. 

Chaque scène a deux cartes des forêts - une pour les conifères et une pour les arbres à feuilles 

caduques. Les noms de fichiers des tuiles de carte forestière pour les conifères commencent par des 

lettres, par ex. s0100.bmp. Les noms de fichiers des tuiles pour les arbres à feuilles caduques 

commencent par la lettre b, par ex. b0100.bmp. Toutes les tuiles de la carte forêt sont placées dans 

le dossier "\Terragen\ForestMaps\" de notre dossier de travail "Working". 

Lorsque vous créez vos propres scènes, inspirez-vous des vraies forêts de la région. Utilisez des 

photos, des images satellites ou aériennes pour découvrir à quoi ressemblent vraiment les forêts. 

Beaucoup de forêts naturelles sont en fait mélangées et seules les forêts cultivées sont des 

monocultures strictes d'une certaine espèce d'arbre. 

Dans notre exemple, cependant, nous essaierons de garder les choses aussi simples que possible. 

Nous utiliserons la carte des forêts de conifères pour toutes les zones des forêts que nous avons 

ajoutées à nos textures et la carte forestière à feuilles caduques pour les arbres solitaires et les petits 

groupes d'arbres présents dans notre texture de base des terres agricoles. 

Création d'une carte de forêt de conifères à partir de l'image du masque de tuile 

Nous allons créer des cartes de forêt de conifères pour nos tuiles en utilisant les images de masque 

que nous avons créées plus tôt. Ouvrez l'un des fichiers de masque dans Paint.NET, par exemple, 
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nous allons utiliser 0000.png. Ajoutez un nouveau calque et remplissez-le de couleur noire. Puis 

déplacez le calque sous le calque d'arrière-plan en cours. Sélectionnez l'outil "Baguette magique" et 

réglez le "Mode de remplissage" sur "global" (si ce n'est pas déjà fait). Maintenant, cliquez sur 

n'importe quelle zone de forêt pour sélectionner toute la forêt sur le masque. Appuyez sur "Ctrl+I" 

pour inverser la sélection, puis sur "Supprimer" pour tout supprimer sauf nos forêts. Maintenant, 

appuyez sur "Ctrl+R" pour redimensionner la tuile à 2048 x 2048 pixels, puis enregistrez l'image 

redimensionnée sous Windows Bitmap - BMP, en la nommant "s0000.bmp". 

Répétez le même processus pour les fichiers 0001.png, 0100.png et 0101.png, en enregistrant les 

images de carte de forêt traitées comme s0001.bmp, s0100.bmp et s0101.bmp. 

Création de la carte de la forêt caduque à partir de la texture de fond des terres agricoles 

Le processus de création des cartes des forêts à feuilles caduques pour notre scène impliquera un 

peu plus de travail. Nous utiliserons à nouveau la "Baguette magique", mais cette fois, il s'agira de 

trouver le bon réglage qui sélectionnerait autant de zones d'arbres dans la texture que possible sans 

sélectionner les parties de l'image qui ne contiennent pas d'arbres. 

 

Figure 21 - Arbres caducs sélectionnés dans une texture 

Nous allons commencer par ouvrir la texture d'origine à partir du pack "HITW HITW-TS2-French-

farm-1.jpg" dans Paint.NET. Choisissez l'outil "Baguette magique", définissez sa tolérance à 12% et le 

"Mode de remplissage" à "Global". Puis cliquez à l'intérieur de l'une des zones de l'arbre dans la 

texture. Vérifiez si la sélection ne contient que des zones arborées et, dans le cas contraire, ajustez la 

tolérance ou essayez de cliquer sur un emplacement différent. 

Les zones arborées de la texture n'ont pas besoin d'être entièrement couvertes avec la sélection, 

mais au moins quelques pixels dans chaque zone doivent être sélectionnés. Nous n'essayons pas 

d'obtenir une forêt dense. Dans ce cas, le moins est le mieux. Une fois que la sélection est à notre 

goût, appuyez sur Ctrl+I pour l'inverser et supprimer les parties indésirables de la texture. 
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Maintenant, ajoutez un nouveau calque, remplissez-le avec la couleur noire et déplacez-le sous le 

calque d'origine. Vous devriez maintenant voir des points verts faibles sur le fond noir. Sélectionnez à 

nouveau le calque comportant des points, et, dans le menu principal, sélectionnez (Ajustements > 

Niveaux). Ajustez les niveaux d'entrée de telle sorte que les points faibles deviennent plus visibles. 

Cela deviendra la base de nos cartes de forêts à feuilles caduques. 

Cependant, la taille actuelle de l'image est seulement de 1024 x 1024 pixels. Nous devons remplir 

toute la tuile de 8192 x 8192 pixels avec cette image. Aplatissez l'image et appliquez le même 

processus d'expansion de copier/coller et de canevas que celui que nous avons utilisé pour créer la 

texture de la tuile des terres agricoles de base. 

Une fois que vous avez créé l'image, de la taille de 8192 x 8192 pixels, remplie de nos petites tuiles, 

ajoutez un nouveau calque rempli de noir en dessous de l'actuel et enregistrez le fichier au format 

".PDN" comme modèle pour la tuile de carte des forêts à feuilles caduques. 

Si nous utilisons la carte des forêts, telle qu'elle est actuellement, elle générera des arbres sur 

l'ensemble de la scène, y compris des endroits qui devraient en être dépourvus. Pour éviter cela, 

nous devons supprimer les données sur les arbres dans les zones couvertes par les zones 

résidentielles, les forêts, les voies navigables, les plans d'eau et les routes. Nous le ferons en utilisant 

nos images de masques créées avec "QGIS". 

Commençons encore une fois avec la tuile 0000. Ouvrez l'image de masque 0000.png et collez-la 

dans notre modèle comme une nouvelle couche. Enregistrez le modèle sous le nom b0000.pdn. 

Maintenant, en utilisant la "baguette magique" avec "Mode de remplissage" défini sur "global", 

sélectionnez toutes les forêts, les zones résidentielles, les plans d'eau, les aéroports et les routes. 

Masquez le calque du masque, passez au calque noir avec des points et supprimez les zones 

sélectionnées. Enregistrez le fichier pour conserver la version en couches pour d'éventuelles mises à 

jour futures. Maintenant, redimensionnez le fichier à 2048 x 2048 pixels et enregistrez-le en tant que 

BMP, c'est-à-dire "b0000.bmp". 
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Maintenant, répétez le même processus pour les trois autres tuiles, en faisant b0001.bmp, 

b0100.bmp et b0101.bmp dans le processus. Ce sont nos dernières tuiles de carte de forêt à feuilles 

caduques. 

Exportation des cartes de forêt vers Condor 

Déplacez tous les fichiers sXXXX.bmp et bXXXX.bmp dans le dossier 

"Working\Terragen\ForestMaps". Maintenant, lancez "Landscape Editor" et ouvrez notre scène 

"Tutorial". Dans le menu principal, sélectionnez "Tools > Import Terragen size forest maps" (Outils > 

Importer des cartes de forêt de taille Terragen). "Landscape Editor" traite toutes les tuiles des cartes 

de forêts. Cochez la case "Forest maps" Cartes de la forêt dans la boîte à outils. Vous devriez 

maintenant voir nos cartes de forêts superposées sur le terrain. 

Maintenant, nous devons exporter les cartes de la forêt à Condor. Dans le menu principal, 

sélectionnez "File > Export forest map" (Fichier > Exporter la carte des forêts). "Landscape Editor" 

traite les deux cartes de forêt et les exporte vers Condor. 

Fermez l'éditeur, lancez Condor et profitez de votre premier vol au-dessus de notre scène couverte 

d'arbres et de plans d'eau rendus avec des effets . 

Création de la carte thermique 

Toutes les régions de la Terre ne supportent pas l'activité convective de la même manière et avec la 

même force. Pour aider à simuler cela, Condor utilise une carte thermique de la surface de la scène. 

La carte a une résolution de 90 mètres par pixel (c'est-à-dire 256 x 256 pixels par tuile) et est 

implémentée en tant qu'image à échelle de gris. La couleur de chaque pixel détermine la probabilité 

et la force de l'activité thermique au point donné, le noir signifiant la plus basse et le blanc la plus 

haute probabilité. 

Veuillez noter que l'algorithme de calcul thermique est différent de celui utilisé à l'origine dans V1. 

En V2, il n'est pas nécessaire d'indiquer des pentes ensoleillées dans la carte thermique, car V2 

travaille directement avec le profil du terrain. En outre, les valeurs de carte thermique sont utilisées 

en relation avec la valeur de "flats activity" (Activité thermique de base) définie dans les paramètres 

météorologiques du plan de vol. 

En bref, si "flats activity" est définie sur "none" (aucune), la carte thermique n'est pas prise en 

compte et toutes les thermiques sont uniquement calculées à partir du profil du terrain et de 

l'exposition au soleil. Avec de tels paramètres, les terrains plats fourniront peu ou pas de thermiques, 

et les thermiques ne seront placés, principalement, que dans les régions de collines et 

montagneuses. Plus "flats activity" est élevée, plus la carte thermique est prise en compte. 

Nous allons créer la carte thermique pour notre scène en utilisant Paint.NET. Pour définir les champs, 

l'herbe et les forêts, nous utiliserons à nouveau nos images de masque. 

D'abord, préparons tout ce dont nous avons besoin. Comme nous l'avons mentionné, chaque surface 

de terrain a une probabilité différente de soutenir l'activité convective. Comme la probabilité est 

déterminée par la luminosité des pixels de notre carte thermique, nous utiliserons les couleurs du 

tableau ci-dessous pour chacun des types de surface qui nous sont importants. 
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Surface Valeurs RVB  Valeurs Hexadécimales  

Water, etc. (no thermals) 

(Eaux, etc.). 

0, 0, 0 000000 

Deciduous trees, shades  

(Arbres caducs, ombres) 

64, 64, 64 404040 

Forests and grass 

(Forêts et herbages) 

102, 102, 102 666666 

Fields 

(Champs) 

178, 178, 178 B2B2B2 

Faisons un calque pour chacune de ces couleurs. 

Créez le premier calque, remplissez-le avec la couleur noire et déplacez-le vers le bas de la pile de 

calques. Continuez avec la couche d'arbres à feuilles caduques, la couche de forêt et la couche de 

champs. Remplissez chacune des couches avec la couleur appropriée du tableau ci-dessus. Enfin, 

ajoutez la dernière couche et laissez-la vide. Nous allons y mettre l'image du masque dans un instant. 

Ouvrez notre fichier "masks.png" et redimensionnez-le à 512x512 pixels. Copiez l'image 

redimensionnée sur la dernière couche de notre image de carte thermique. Vous pouvez ensuite 

fermer masks.png sans enregistrer les modifications pour conserver le fichier avec les calques 

d'origine. 

Nous allons maintenant composer la carte thermique de la même manière que nos textures. 

Basculez vers la couche contenant des masques et utilisez la "Baguette magique" (avec le "Mode de 

remplissage" défini sur "Global" et la "Tolérance" à petite, mais non nulle), cliquez sur l'un des 

champs orange. Tous les champs devraient maintenant être sélectionnés. Appuyez sur Ctrl+I pour 

inverser la sélection et passer au calque des champs (le gris le plus clair des trois). Appuyez sur 

"Supprimer" pour supprimer les zones en trop et conserver uniquement les parties marquées 

comme champs dans notre image de masque. 

Maintenant, nous devons sélectionner toutes les forêts. Nous sélectionnerons également toutes les 

zones résidentielles, car les rues et les parkings génèrent également beaucoup d'air chaud. C'est à 

vous de décider, si vous décidez de donner aux villes et aux villages plus ou moins de probabilité dans 

votre propre scène en les incluant dans différentes couches. Nous les inclurons dans la même couche 

que les forêts dans notre exemple. 

Basculez de nouveau sur le calque de masque et utilisez "Baguette magique" pour sélectionner 

toutes les forêts en cliquant sur l'une d'entre elles. Maintenant, appuyez et maintenez la touche Ctrl 

et cliquez sur l'une des villes pour sélectionner toute la zone résidentielle. Nous devrions maintenant 

avoir toutes les forêts et les villes sélectionnées. Appuyez sur Ctrl+I pour inverser la sélection et 

basculer vers la couche grise du milieu. Appuyez sur "Supprimer" pour supprimer les parties inutiles 

de l'image et ne conserver que les forêts et les zones résidentielles. 

Maintenant, revenez au calque de masque et utilisez la baguette magique pour sélectionner toutes 

les zones blanches du masque. Appuyez sur Ctrl+I pour inverser la sélection, basculez sur le calque 

avec la couleur grise la plus foncée et appuyez sur "Supprimer". 
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Figure 22 -Carte thermique réalisée pour la scène Tutorial 

Enregistrez l'image en couches au format .PDN afin de la conserver pour d'éventuels ajustements 

futurs. Ensuite, modifiez le format de fichier en .BMP et enregistrez-le en tant que ThermalMap.bmp 

à la racine du dossier \Working \, c'est-à-dire \Landscapes\Tutorial\Working\ThermalMap.bmp. 

NOTE: Comme vous avez pu le remarquer, la structure des champs de notre texture d'arrière-plan est 

différente de celle de la carte thermique. C'est parce que nous utilisons des données OSM pour 

générer une carte thermique. Si vous vouliez la même disposition de champ que dans la texture 

d'arrière-plan, vous devez créer la carte des champs à la main. Cela prendrait beaucoup de temps, 

c'est pourquoi nous avons utilisé les données des champs réelles pour accélérer le processus. 

Nous pouvons maintenant fermer "Paint.NET" et ouvrir notre scène dans "Landscape Editor". Cliquez 

sur "Thermal Map" (Carte Thermique) dans la boîte à outils. Si notre carte thermique apparaît 

superposée sur le terrain, nous pouvons sélectionner "File > Export thermal map" (Fichier > Exporter 

la carte thermique) et nous avons terminé ! 

Ceci conclut la première partie du didacticiel de création de scène. Cependant, notre terrain est 

toujours dépourvu d'aéroports et d'autres objets. Nous discuterons de la création et de l'ajout de 

ceux-ci dans les chapitres suivants. 
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7. Création et ajout d'objets 3D pour la scène, d'aéroports 

personnalisés et de points tournants 
Nous avons terminé notre terrain, mais jusqu'à présent, les seuls objets 3D que nous voyons à la 

surface sont des arbres générés à l'aide de cartes de forêt. Dans ce chapitre, nous discuterons de 

l'ajout d'objets personnalisés et d'aéroports à notre scène. Nous mentionnerons également 

comment les objets et les aéroports peuvent être créés, bien que très brièvement, car la création 

d'objets fait l'objet de tutoriels et de guides distincts. Cependant, un minimum de connaissances de 

base sur la modélisation 3D est attendu du lecteur pour comprendre ce chapitre. 

Comme Condor est principalement un simulateur de compétition, nous allons également expliquer 

comment ajouter des points de virage qui peuvent être utilisés pour la définition des circuits. 

Brève introduction à la création d'objets 3D 
En général, nous avons deux types d'objets personnalisés dans les scènes Condor 2 - les objets de 

scène et les aéroports. Condor utilise son format binaire interne pour stocker tous les objets, sous la 

forme de fichiers - C3D. 

L'objet de scène est un modèle 3D créé pour être placé à un endroit quelconque de notre scène. Ils 

peuvent être tout ce que vous trouvez dans le terrain réel, comme des maisons ou des pâtés de 

maisons entiers, des châteaux, des tours d'antennes, des ponts et même des objets spéciaux comme 

des trains, des avions stationnés ou des machines agricoles. Le but des objets de scène est de rendre 

la scène plus plastique et plus proche de la réalité. Le contenu d'un fichier C3D est considéré comme 

un objet de scène, même s'il peut s'agir d'une petite scène complète composée de plusieurs objets 

3D. 

Les aéroports personnalisés sont des types spéciaux d'objets représentant des aéroports entiers, y 

compris des pistes, des hangars, d'autres bâtiments, des voitures, des avions statiques, etc. 

Les objets de scène et les aéroports sont placés dans la scène à l'aide de Landscape Editor, l'éditeur 

de scène. Toutefois, en fonction de leur objectif, les fichiers eux-mêmes sont stockés dans différents 

dossiers de la structure de dossiers de la scène. 

Les objets que l'on veut placer dans une scène sont stockés dans le dossier \World\Objects de 

chaque scène. Leurs textures associées doivent être stockées dans le sous-dossier Textures, c'est à 

dire : 

• les fichiers d'objet dans : \Landscapes\LandscapeName\World\Objects\ 

• les textures associées dans : \Landscapes\LandscapeName\World\Objects\Textures\ 

Les aéroports sont stockés dans le dossier \Airports de chaque scène. Chaque aéroport se compose 

de deux fichiers - un fichier G et un fichier O. Le fichier G contient tous les objets de surface près du 

sol de l'aéroport (pistes en herbe et/ou asphalte, voies de circulation et leur marquage). Le fichier O 

contient tous les autres objets 3D du modèle d'aéroport - hangars, tour, manches à air, aéronefs, 

voitures, arbres, etc. Tous les objets inclus dans le fichier O sont «générateurs de crashs», c'est-à-dire 

qu'ils sont sensibles aux collisions et provoquent le crash du planeur. 

Il est recommandé de créer un sous-dossier distinct pour les textures propres à chaque aéroport (le 

nom du dossier vous appartient, mais il est recommandé d'utiliser un identifiant compréhensible, 
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comme l'ID de l'aéroport ICAO). Si nécessaire, un autre sous-dossier peut être utilisé pour les 

textures communes partagées entre plusieurs aéroports. La structure de dossier recommandée 

ressemble à ceci : 

• Fichiers G et O de l'aéroport : \Landscapes\LandscapeName\Airports\ 

• Textures uniques d'aéroport: \Landscapes\LandscapeName\Airports\XXXX\ 

• Textures partagées: \Landscapes\LandscapeName\Airports\Common 

Il est recommandé d'utiliser un chemin relatif aux textures de vos objets, car cela facilite le transfert 

et la réutilisation des objets, en particulier si vous créez des objets pouvant être utilisés dans 

plusieurs scènes. 

Outils nécessaires pour la création d'objets 3D 

Vous avez besoin de plusieurs outils pour créer et exporter un modèle 3D à utiliser comme objet de 

scène dans Condor. Cependant, le flux de travail a changé par rapport à V1 et il est maintenant plus 

ouvert et plus direct. Le changement le plus important est l'utilisation du fichier ".OBJ" de 

"Wavefront" au lieu de ".3DS" de "3D Max" utilisé dans la V1. Cela permet aux créateurs d'objets 

d'utiliser une plus grande variété de logiciels de modélisation, allant des applications payantes (et 

coûteuses) comme "Autodesk", "3D Studio MAX" et "Rhinoceros" à des alternatives open source 

comme "Wings3D" ou "Blender". 

NOTE: Wings3D a été l'application préférée dans l'équipe de développement du noyau de Condor 

depuis V1, mais il sera probablement remplacé par Blender bientôt. Cependant, cela ne signifie 

nullement que ce sont les seules alternatives possibles. Quelques planeurs et remorqueurs pour la V2 

ont été créés en 3D Max, et des objets de scène en 3D Max, Blender et Wings3D. Donc, tant que vous 

êtes en mesure d'exporter au format "OBJ", vous pouvez utiliser le logiciel que vous voulez. 

 

Flux de travail général pour la création d'objets 3D pour Condor 2 
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Les règles générales les plus importantes pour créer des "objets de scène" et des aéroports 

Il existe quelques règles importantes à prendre en compte lors de la création d'objets pour V2. 

Même si vous êtes un auteur expérimenté d'objets pour V1, ne sous-estimez pas les exigences, car 

certaines d'entre elles sont très différentes de celles de V1. Par souci de clarté, nous utiliserons 

dorénavant le terme "landscape object" (objet de Scène) pour l'ensemble du fichier C3D et 

"scene object" (objet standard) pour tous les objets composant et se trouvant à l'intérieur d'un objet 

de scène. 

Lors de la modélisation, gardez les éléments suivants à l'esprit : 

1. Condor utilise le mètre comme unité de mesure. Définissez votre logiciel de modélisation en 

conséquence. 

2. Les matériaux multiples ne sont pas supportés dans V2. Chaque "objet standard" doit avoir 

un seul matériau affecté. Cela signifie également que chaque "objet standard" ne peut avoir 

qu'une seule texture. Si vous essayez d'adapter un objet multi-matière de V1 à V2, vous 

devez, soit regrouper les textures en combinant les objets pour obtenir une seule texture, 

soit le diviser en plusieurs objets texturés avec une seule texture. 

3. Contrairement à V1, la couleur du matériau d'un objet texturé influence la façon dont l'objet 

est rendu dans le jeu. Si la couleur du matériau est différente du blanc complet (R: 255, V: 

255, B: 255), la texture de l'objet apparaîtra plus sombre et/ou teintée. 

4. Les objets de scène dans V2 sont ombrés dynamiquement. Il est recommandé d'éviter 

l'ombrage dans les textures d'objets, si possible. 

5. Les polygones de surface "Grass" et "Asphalt" au sol dans le fichier G de l'aéroport ne doivent 

pas se chevaucher, sinon le résultat visuel est imprévisible. Les objets de scène provenant du 

fichier O peuvent "se poser" sur les polygones au sol définis dans le fichier G. 

6. Jusqu'à 3 manches à air dynamiques peuvent être placées dans un fichier O de l'aéroport. 

7. Les aéroports n'ont pas de polygones "d'herbe" sous-jacents. La zone d'herbe de l'aéroport 

doit être dessinée sur la texture de la scène. 

Les bases de la création des aéroports 
Comme mentionné précédemment, les aéroports de Condor V2 se composent de deux fichiers 

objets, le fichier G et le fichier O, laissant de côté le fichier S utilisé dans V1 pour définir la surface du 

sol. 

Fichier G - polygones du terrain de l'aéroport 

Le fichier Airport G peut comprendre jusqu'à quatre "objets de scène" ayant chacun un objectif 

spécifique. Chaque objet peut comprendre plusieurs polygones, mais ils doivent être combinés pour 

former un seul objet (mais pas un groupe d'objets !). 

Objet "Grass" 

Avec V2, l'herbe n'est pas utilisée pour dessiner la pelouse de l'aéroport de la même manière qu'en 

V1. L'objet "Grass" est utilisé pour ajouter un effet de surface d'herbe à haute résolution aux pistes 

en herbe et aux zones adjacentes. Pensez à cet objet comme s'il s'agissait d'une décalcomanie semi-

opaque spéciale affichée sur la surface régulière du paysage. Lorsque vous arrivez à une certaine 

distance de l'objet, il commence à apparaître. Plus vous êtes proche, plus il est visible. Une fois que 
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vous êtes sur le sol, vous verrez l'herbe générée par cet objet au lieu de la texture sous-jacente de la 

scène. 

Pour créer l'objet "Grass", créez un polygone d'une forme requise. Si nécessaire, vous pouvez créer 

plusieurs polygones, mais ils doivent être combinés en un seul objet polygone à la fin. Changez le 

nom de l'objet en "Grass". 

Pour afficher correctement l'effet d'herbe, l'objet doit faire l'objet d'un mappage UVW. Cette 

procédure est différente dans chaque application de modélisation. Selon l'application utilisée, le 

mappage UVW ou "UV MAPPING" peut être effectué avec ou sans texture réelle affectée à l'objet. La 

texture affectée à l'objet est ignorée dans le jeu et la texture d'effet d'herbe par défaut est utilisée. 

La taille de l'effet d'herbe (la taille de l'herbe est importante) est déterminée par l'aire du patron de 

la texture - plus la surface est petite, plus l'herbe est grande. Cela peut être ajusté en redéployant 

UVW et en changeant la taille du patron de la texture. Comme chaque piste est différente, la bonne 

taille de la texture cartographiée fera l'objet de tests avec des réussites ou des échecs. Essayez de 

changer la taille du patron jusqu'à ce que le résultat au cours de la simulation soit satisfaisant. 

Objet "Asphalt" 

Un objet au sol "Asphalt" devrait être utilisé pour représenter les pistes en asphalte, les voies de 

circulation et les autres zones aéroportuaires pavées. Contrairement à l'objet "Grass", l'objet 

"Asphalt" est toujours visible. Cependant, la structure détaillée de la surface est montrée dans le 

même style que pour l'herbe et le même processus de cartographie UVW s'applique là aussi. 

Tous les polygones "Asphalt" doivent être combinés en un objet nommé "Asphalt". 

Objets "Grasspaint" et "Asphaltpaint" 

Les marques de piste et de voie de circulation sont faites à l'aide d'objets "Grasspaint" et 

"Asphaltpaint". Chacun de ces objets est spécifique au type de surface sous-jacent. Les objets "Paint" 

peuvent être modélisés et à la fois texturés ou non texturés, mais dans la simulation, la texture 

affectée est ignorée et la texture par défaut pour le type "paint" particulier est utilisée. 

La texture de "Grasspaint" représente des feuilles d'herbe peintes en blanc (dans le même style que 

le marquage à la chaux sur un terrain de football). 

La texture "Asphaltpaint" montre de la peinture blanche craquelée sur une surface d'asphalte. 

L'utilisation de "Grasspaint" et de "Asphaltpaint" n'est pas limitée aux surfaces d'herbe et d'asphalte 

respectivement. Comme de nombreux aéroports utilisent des marqueurs de piste solides, même 

pour les pistes en herbe (blocs de béton ou carreaux peints en blanc), nous pouvons également 

utiliser "Asphaltpaint" sur un objet "Grass" pour le représenter. Cependant, l'utilisation de 

"Grasspaint" sur un objet "Asphalt" n'est pas recommandée. 

Remarques sur la création d'un fichier G 

Les 4 objets décrits ci-dessus ne doivent pas nécessairement être présents dans un fichier G, mais il 

est important de s'assurer que les objets "Grass" et "Asphalt" ne se chevauchent pas. Comme 

mentionné dans le chapitre précédent, le chevauchement conduit à des résultats indésirables. Il est 

également recommandé d'étendre l'objet "Grass" sur toute la surface de l'herbe de l'aéroport, de 

sorte que l'effet de haute résolution soit présent sur l'ensemble de l'aéroport, et pas seulement sur 

la piste. Les objets "Grasspaint" et "Asphaltpaint" peuvent être placés sur les objets "Grass" et 

"Asphalt", autant que nécessaires, sans présenter d'effets indésirables. 
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Fichier O - tous les objets de l'aéroport 

Les fichiers Airport O contiennent tous les autres objets de l'aéroport - bâtiments, hangars, 

équipement au sol ou véhicules. Les fichiers O peuvent également contenir jusqu'à trois manches à 

air dynamiques. 

Ajouter des manches à air 

Pour placer une manche à air dans le modèle d'aéroport, nous devons créer un objet proxy pour 

celle-ci. Comme nous pouvons avoir trois manches à air, les objets proxy sont appelés "Windsack1", 

"Windsack2" et "Windsack3". La position et la taille de l'objet proxy détermine le point où la manche 

à air est attachée au poteau et sa taille. 

L'objet proxy de la manche à air est un triangle équilatéral. Le centre du triangle est le point où les 

cordes de manche à air sont attachées au poteau. La taille de la manche à air elle-même est le 

centuple du rayon du cercle circonscrit du triangle. 

 

Figure 23 - Objets "windsock" proxy de 2.5 cm, 5 cm et 10 cm 

La figure 23 montre des proxies triangulaires définissant trois objets de manche à air. Chaque triangle 

est placé à 2 cm au-dessus d'un poteau de 10 mètres de haut et de 15 cm de diamètre. De gauche à 

droite, les rayons de leurs cercles circonscrits sont de 2,5 cm, 5 cm et 10 cm. La figure 24 est une 

capture d'écran du simulateur des mêmes poteaux placés sur un aérodrome. De gauche à droite, les  

longueurs des manches à air sont de 2,5 mètres, 5 mètres et 10 mètres. 

 
Figure 24 - Manches à air générées par les objets proxy de la Figure 23 
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Modélisation d'un aéroport générique simple pour notre scène "Tutorial" 
Ce chapitre décrit brièvement le flux de travail pour la modélisation d'un aéroport simple que nous 

pourrons placer dans notre scène "Tutorial". 

Veuillez noter que, bien que les images illustrant ce chapitre soient prises dans 3D Max, le processus 

lui-même est décrit en termes généraux. A minima, une connaissance de base du logiciel de 

modélisation 3D est attendue pour concevoir des aéroports dans les scènes. 

Notre aéroport n'aura qu'une piste en herbe avec des marqueurs de piste, un hangar avec une petite 

zone d'asphalte en face de lui et une manche à air avec un marqueur au sol. 

Création des polygones du sol 

Les aéroports de V2 n'ont pas de polygone de surface sous-jacent définissant la zone aéroportuaire 

réelle et reposent sur la zone déjà représentée dans la texture de la scène (nous avons abordé ce 

problème dans le chapitre sur les textures de scène). Cette approche était en fait utilisée par 

beaucoup de scènes V1. 

REMARQUE: avant de commencer la modélisation, vérifiez que vous utilisez le mètre comme unité 

dans votre logiciel de modélisation. Si ce n'est pas le cas, changez le paramètre d'unité en mètre. 

Commençons par faire la piste. Ce sera 800 mètres de long et 60 mètres de large. Ce sera un objet 

auxiliaire, car il ne sera utilisé qu'à titre de référence et ne sera pas exporté vers Condor. La longueur 

de la piste devrait être le long de l'axe X. Créez un polygone de la taille donnée ci-dessus et placez-le 

afin que son point central soit aux coordonnées d'origine: 0, 0, 0. Ceci est notre point de référence 

pour l'ensemble de l'aéroport. 

Maintenant, nous allons préparer l'objet "Grass". Nous allons faire un autre polygone, cette fois avec 

une forme un peu plus compliquée (voir l'image ci-dessous). Nous nommerons cet objet "Grass". 

 

Figure 25 - Le polygone "Grass" avec le polygone d'aide figurant la piste 

Maintenant, faisons les marqueurs de piste. Nous les ferons d'abord en tant que polygones séparés, 

puis nous les combinerons en un seul objet "Grasspaint". Au total, nous aurons 4 marqueurs de coin 

et 7 paires de marqueurs de bordure réguliers. Les marqueurs de bordures seront des rectangles de 3 

mètres de long et de 1 mètre de large et seront placés le long de la bordure de la piste tous les 100 

mètres. Les marqueurs de coin seront des polygones en forme de L, de 2 mètres de large et de 4 

mètres de long, et chacun d'eux sera placé à chaque coin de la piste. 
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Figure 26 - Marqueurs de piste "Grasspaint" 

Un autre marquage au sol que nous devons créer est le cercle autour de la manche à vent. Il aura le 

diamètre extérieur de 10 mètres et de 0,5 mètre de largeur. Nous placerons plus tard la manche à 

vent au centre de celui-ci. 

Ajoutons le dernier objet qui fera partie du fichier G de notre aéroport - la zone d'asphalte autour du 

hangar. Les dimensions horizontales du hangar seront de 40 mètres sur 15 mètres. La taille de notre 

zone d'asphalte sera de 60 mètres par 35 mètres et le nom de l'objet sera "Asphalt". Nous ne devons 

pas oublier que les objets "Grass" et "Asphalt" ne peuvent pas se chevaucher. Nous devons couper 

un trou pour la zone d'asphalte à l'intérieur de notre objet "Grass" (par exemple en utilisant un 

découpage booléen ou toute autre méthode de votre cru). 

 

Figure 27 - Le marqueur, de l'emplacement de la manche à air : un cercle de 10 m 

Nous avons tous les polygones terrestres dont nous avons besoin. Maintenant, nous devons 

fusionner toutes les marques au sol dans l'objet "Grasspaint". Une fois que nous avons terminé, nous 

pouvons passer à une autre étape très importante - nous devons appliquer la cartographie UVW aux 

trois objets au sol. 

Premièrement, nous devons créer un nouveau matériau et définir sa couleur à blanc. Il ne doit pas 

être texturé, mais cela peut aider à une meilleure visualisation de l'aéroport dans votre modeleur. 

Les textures seront ignorées dans Condor 2. Une fois que les matériaux pour tous les objets sont 

définis, nous pouvons commencer la cartographie. 

 

Figure 28 - Tous les objets au sol de notre aéroport du tutoriel 



  Page 49 sur 64 

49 

 

Commençons par appliquer le mappage UVW à l'objet "Grass". Plus la partie de la texture prise par 

l'objet est grande, plus le détail de l'herbe haute résolution rendu dans le jeu sera petit. Ce principe 

s'applique à tous les objets du fichier G. 

 

Figure 29 - UVW mapping de l'objet "Grass" 

Après avoir cartographié les trois objets, nous pouvons considérer que le contenu du fichier G de 

notre aéroport est prêt. 

Nous allons maintenant ajouter un hangar et un poteau avec l'objet proxy de manche à air à notre 

scène. 

 

Figure 30 - L'objet hangar 

Le hangar sera construit comme une boîte de 40 mètres de large, 15 mètres de profondeur et 9 

mètres de haut. Changez la hauteur du mur arrière à 7 mètres et appliquez de la texture. Vous 

pouvez utiliser le fichier "hangar_texture.bmp" disponible avec ce guide. 

Maintenant, nous allons créer le poteau de la manche à air et l'objet proxy de la manche à air. Nous 

avons déjà créé le marquage au sol pour le manche à vent et le poteau sera placé au centre de celui-

ci. Nous allons le concevoir comme un poteau de 8 mètres de haut et 10 centimètres de diamètre. 

L'objet triangle de proxy sera placé au-dessus de celui-ci et le rayon de son cercle circonscrit sera de 

4 centimètres (il générera 4 mètres de longueur de manche à air). Nous allons changer son nom pour 

Windsack1. Les utilisateurs de 3D Max font attention, tous les objets doivent être convertis en 

maillage éditable ou en polygones éditables avant d'exporter ! Sinon, les objets ne peuvent pas être 

exportés. 
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Figure 31 - Ajout du poteau de manche à air et de son triangle "proxi" 

Sauvegardez votre fichier. Maintenant, nous pouvons exporter à la fois le fichier G et le fichier O. 

Sélectionnez les objets "Grass", "Asphalt" et "Grasspaint" et exportez-les dans le format "Wavefront 

OBJ". Pour le fichier G, le nom de fichier doit être XxxxG.obj, où Xxxx est le nom de l'aéroport que 

nous utiliserons dans Landscape Editor. Nous allons exporter le fichier sous TutorialG.obj pour 

l'instant. 

Il est très important d'exporter les faces en tant que triangles lors de l'exportation. Aussi, pour des 

applications comme 3D Max, où les coordonnées X et Y sont sur le plan horizontal et les coordonnées 

Z dans la direction verticale, n'oubliez pas de régler l'export pour retourner l'axe YZ. Les paramètres 

d'exportation de 3D Max et Wings3D sont ci-dessous : 

             

 

Maintenant, sélectionnez le hangar, le poteau et le triangle du proxy de la manche à air et exportez-

les dans un objet "OBJ" en utilisant le même processus. Enregistrez le fichier sous le nom 

TutorialO.obj. 

Sauvegardez votre aéroport et fermez l'application de modélisation 3D, elle ne sera plus nécessaire 

maintenant (sauf si vous décidez de revenir en arrière et de changer quelque chose dans l'immédiat) 
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Maintenant, nous devons convertir les deux fichiers "OBJ" au format "C3D" interne de Condor. 

Démarrez "Object Editor" (l'éditeur d'objets) et ouvrez le "TutorialG.obj". N'ayez pas peur que l'objet 

soit entièrement noir, "Object Editor" affiche tous les objets non texturés après l'importation "OBJ". 

Toutes les couleurs du matériau seront présentes dans le fichier "C3D" enregistré. 

Vérifiez si tous les objets ont une valeur de 1.00 dans leurs attributs "Red" (Rouge), "Green" (Vert) et 

"Blue" (Bleu). Si ce n'est pas le cas, attribuez-leur cette valeur. Enregistrez ensuite le fichier au format 

"C3D" à l'aide de "File > Save to C3D" (Fichier > Enregistrer dans C3D). 

 

Chargez le "tutorialO.obj". Pour les fichiers O, regardez si tous les objets ont une texture (l'attribut 

Texture ne doit pas être vide) et vérifiez que leur paramètre de matériau est 1.00 pour Rouge, Vert et 

Bleu, comme dans l'étape précédente. Sinon, changez-les de la même manière. Comme pour les 

objets non texturés, la couleur est déterminée par la couleur de leur matériau, gardez leurs 

paramètres tels qu'ils sont. 

Dans notre cas, nous n'avons qu'un objet texturé - le hangar. En plus, vérifier les valeurs R, G, B, nous 

devons également ajuster le chemin de la texture. Comme nos fichiers d'aéroport seront utilisés pour 

chaque aéroport de notre scène, ce qui signifie qu'il sera éventuellement sauvegardé sous plusieurs 

noms, nous définirons le chemin de texture à "Common\hangar_texture.bmp". Bien sûr, nous 

devons copier le fichier à cet endroit. Pour notre exemple, ce serait dans : 

"Landscapes\Tutorial\Airports\Common". 

Comme nous avons déjà placé un aéroport dans notre scène, copions également les deux fichiers 

C3D dans le dossier Airports en tant que PodhoranyG.c3d et PodhoranyO.c3d. 

Travailler avec les aéroports dans Landscape Editor 
Lancez "Landscape Editor", l'éditeur de scène et ouvrez notre scène "Tutorial". Cochez "Airports" 

(Aéroports) pour voir les aéroports et sélectionnez le seul aéroport que nous avons ajouté jusqu'à 

présent. Cochez "Draw objects" (Dessiner des objets) pour voir la structure filaire de tous les objets 

de l'aéroport. Vous verrez que notre aéroport générique est un peu plus long que la vraie piste et 

que notre hangar est en dehors de la zone herbeuse du vrai aéroport. Une solution facile consiste à 

tourner la piste de 180 degrés, c'est-à-dire d'entrer 253 degrés comme direction de la piste, au lieu 

des 73 degrés d'origine. Ensuite, l'aéroport devrait ressembler à la photo ci-dessous. 

Nous n'avons toujours pas fini. Vous verriez cela si vous essayiez d'utiliser l'aéroport pour décoller ou 

atterrir. Pour pouvoir l'utiliser correctement, nous devons aplanir la surface du terrain sous 
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l'aéroport. Rappelez-vous l'altitude de l'aéroport (381 mètres), car nous devons aplatir la zone à 

cette altitude. 

  

Passez à la vue "Height map" (Carte des hauteurs) et effectuez un zoom sur l'aéroport. Puis cliquez 

sur le bouton FLATTEN pour activer la fonction d'aplatissement. Définissez le rayon à la valeur qui 

vous convient et l'altitude à 381 mètres. Puis "Edge slope" (Pente de bordure) à une autre valeur que 

1: 0. Cela activera le lissage de l'altitude environnante. Plus le rapport est élevé, plus la zone affectée 

par le lissage est grande. Cela aide à adoucir la transition entre la surface aplatie et la surface non 

aplatie. Notez la signification du curseur - le cercle intérieur est la zone où l'altitude est définie sur la 

valeur saisie, le cercle externe indique la zone où le maillage du terrain est lissé pour se fondre avec 

la zone aplatie. 

Rappelez-vous aussi que cette fonction d'aplatissement sera utile lorsque vous placerez des objets de 

scène. 

 

À partir de Condor 2 version 2.0.8, la direction de la piste de l’aéroport peut être 
saisie comme un nombre décimal. Cela donne aux concepteurs de scènes plus de 
flexibilité lors de l’alignement des aéroports avec les textures (en particulier pour 
les scènes photo-satellites). Cette fonctionnalité est supportée par Landscape 
Editor version 2.0.1 et supérieure. 

 

Les scènes créées avec Landscape Editor 2.0.1+ ne peuvent être utilisés que dans 
Condor 2 version 2.0.8 et au dessus! Condor 2 est toujours compatible avec les 
scènes plus anciennes déjà créées en utilisant "Landscape Editor" version 2.0 et 
tant qu’il n’est pas nécessaire d’utiliser une valeur décimale pour la direction de la 
piste, aucun changement n’a besoin d’être fait pour des scènes déjà existantes. 
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Enfin, une fois que nous avons aplani toute la zone sous la pelouse dans la texture, nous pouvons 

sauvegarder la scène et faire un test dans Condor. 

 

Figure 32 - Notre aéroport personnalisé dans Condor 

Voici la liste de tous les aéroports qui manquent encore dans notre scène. Vous pouvez les ajouter de 

la même manière que nous avons ajouté Podhořany. 

Havlíčkův Brod (dans le nom du jeu "Havlickuv Brod") 

 Lat: 49.601898 

 Lon: 15.536500 

 Piste - longueur: 1000 m, largeur: 50 m, direction: 113 degrés 

 Altitude: 450 m 

 Noms de fichiers : Havlickuv BrodG.c3d, Havlickuv BrodO.c3d 
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Chotěboř (dans le nom du jeu "Chotebor") 

 Lat: 49.684925 

 Lon: 15.675970 

 Piste - longueur: 1010 m, largeur: 50 m, direction: 167 degrés 

 Altitude: 580 m 

 Noms de fichiers : ChoteborG.c3d, ChoteborO.c3d 

Chrudim 

 Lat: 49.945400 

 Lon: 15.771000 

 Piste - longueur: 980 m, largeur: 160 m, direction: 230 degrés 

 Altitude: 290 m 

 Noms de fichiers : ChrudimG.c3d, ChrudimO.c3d 

Ajouter des "objets de Scéne" 
Les "objets de Scéne" (Landscapes Objects) sont créés de la même manière que les aéroports. 

Comme dans les aéroports, un objet c3d peut consisté d'un, ou de plusieurs "objets Standard". 

La scène Slovenia2 contient des dizaines d'objets gratuits pour chaque créateur de scènes. Pour les 

utiliser, il suffit de les copier dans le dossier "\World\Objects" de notre scène. N'oubliez pas de 

vérifier les chemins de texture dans l'éditeur d'objets et de les modifier en conséquence. Les textures 

utilisées par les objets doivent être placées dans le dossier "\World\ Objects\Textures". 
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Pour placer des objets dans la scène, sélectionnez la fonction "Ground Objects" (Objets au sol). 

Choisissez l'objet que vous souhaitez placer dans la liste déroulante "Object". Vous pouvez placer un 

objet ou un groupe d'objets multiples à la fois. L'option "Cluster" vous permet de placer des objets au 

hasard dans une zone de rayon donné. 

Lorsque vous effectuez un zoom avant maximal, vous pouvez placer des objets uniques très 

précisément (mettre des trains sur les voies ferrées, etc.). 

Pour supprimer des objets, utilisez le mode de sélection (grande flèche noire inclinée), cliquez sur un 

objet ou sélectionnez plusieurs objets en faisant glisser le rectangle de sélection sur eux, puis 

appuyez sur Supprimer. Vous pouvez également utiliser l'outil Gomme. 

Si vous placez des objets de grandes tailles, il peut être nécessaire d'aplatir la surface en dessous. Si 

la surface sous l'objet n'est pas plate, une partie de l'objet peut être dans l'air et une autre partie 

enfouie dans le terrain. 

Placer des "objets de scène" est aussi un processus d'essais et d'échecs. Finalement, chaque créateur 

de scène trouvera le bon équilibre entre trop ou trop peu d'objets et la beauté de la scène. Mais 

comme vous pouvez le voir sur la photo ci-dessous, les objets de scène rendront la scène plus 

vivante. 
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Figure 33 - Terrain avec de maisons de villages ajoutées (en haut, à gauche) 

Ajouter des "waypoints" (points de virage) 
Après tout, Condor 2 est un simulateur de vol destiné à la compétition, nous devons donc fournir aux 

concepteurs de circuits des "waypoints" qui peuvent être utilisés pour créer des circuits de 

compétition. Pour pouvoir créer un circuit avec des points de virage autres que les aéroports, nous 

devons ajouter une liste de points de cheminement personnalisés. Le seul inconvénient est qu'ils ne 

sont pas visibles dans l'éditeur de scène et ne peuvent être consultés que dans la fenêtre du 

planificateur de vol de Condor. 

Les "waypoints" sont stockés dans un fichier CUP placé dans le dossier racine de la scène. Le fichier 

porte le même nom que la scène, par ex. "Tutorial.cup", et est en fait un fichier de waypoints 

standard. Il existe plusieurs façons de créer ou d'obtenir un fichier de waypoints pour votre scène, de 

le compiler manuellement pour le générer en utilisant un logiciel spécialisé. 

L'une des sources des bases de données de points de cheminement est le site Web Worldwide 

Soaring Turnpoint Exchange disponible à l'adresse http://soaringweb.org/TP. Une des 

caractéristiques internes de Condor est la réduction des listes de "waypoints" - si vous fournissez une 

liste de "waypoints" avec des "waypoints" se trouvant en dehors de votre scène, Condor enlèvera 

automatiquement ces "waypoints" et ne les conservera que dans la zone de la scène. Cela se produit 

automatiquement lorsque vous démarrez un vol dans la scène. Pour obtenir des waypoints dans 

notre scène, il suffit de télécharger le fichier CUP pour la République tchèque sur le site ci-dessus, de 

le renommer Tutorial.cup et de le placer dans le dossier "Tutorial". La prochaine fois que vous 

planifierez un vol dans la scène, vous devrez voir les waypoints dans le planificateur de vol et après 

avoir terminé votre vol, seuls les waypoints pertinents resteront dans le fichier de "waypoints". 

L'autre option pour obtenir un fichier de waypoints personnalisé est d'utiliser l'application "See You" 

de la société slovène "Naviter". "See You" est actuellement l'une des normes pour l'établissement 

des circuits, la planification de vol et l'analyse après vol. Cependant, c'est un payware, disponible 

gratuitement seulement pour une période d'essai de 14 jours. Vous pouvez être téléchargé "See You" 

sur http://www.naviter.com/products/seeyou/. 

http://soaringweb.org/TP
http://www.naviter.com/products/seeyou/
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Ceci conclut notre tutoriel de scène. Félicitations, si vous avez lu jusqu'ici, vous devriez savoir tout 

ce dont vous avez besoin pour créer votre propre scène      . Pour tout le reste, il y a le forum de 

développement de scènes sur le site Web de Condor. 
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8. Conversion d'une scène V1 pour une utilisation avec V2 
De nombreux concepteurs de scène vous demanderont: «Comment puis-je convertir mon ancienne 

scène V1 pour une utilisation en V2 ?» Pour être honnête, la réponse devrait probablement être: «Ne 

le faites pas !» Mais comme ce n'est pas la réponse, que la plupart des gens voudraient entendre, 

nous allons discuter des possibilités et des étapes requises pour convertir les scènes V1 en V2 dans ce 

chapitre. 

La première question à laquelle vous devez répondre est de savoir ce que vous attendez d'une scène 

convertie. Est-ce qu'une simple conversion avec les mêmes données de terrain que dans V1 serait 

suffisante ? Ou voulez-vous améliorer le terrain en utilisant des données de 30 m ? Créer de 

meilleures textures ? Tout ceci influence le flux de travail de conversion. Finalement, vous pouvez 

découvrir que dans certaines situations, créer une nouvelle scène à partir de zéro serait plus facile. 

Jetons un coup d'œil sur ce qui doit être fait si la scène V1 doit être convertie en scène V2 : 

1. Le terrain doit être converti à la résolution utilisée dans V2. 

a. Si vous avez l'intention de conserver l'ancien terrain de 90 m, tout ce que vous avez à 

faire est de le convertir en utilisant l'outil "TrnToTr3". Cela permettra de sauver 

l'ancien terrain dans le nouveau format, mais en gardant la basse résolution 

d'origine. Le terrain restera calibré et tout ce que vous devez faire est de vérifier les 

zones aplaties. Si vous choisissez de le faire, vous pouvez passer directement à 

l'étape n °. 4. 

b. Si vous souhaitez augmenter la résolution du terrain en utilisant des données de 

terrain de 30 m, vous devez créer le terrain entier à partir de zéro. Il y a deux 

possibilités : 

i. Vous connaissez les coordonnées exactes de l'un des coins de votre scène. 

Dans ce cas, vous pouvez créer le terrain tel qu'il est montré dans notre 

tutoriel. 

ii. Vous ne connaissez pas les coordonnées. Dans ce cas, vous devez utiliser la 

procédure décrite plus loin dans ce chapitre. 

2. Le terrain doit être calibré (soit lors de l'exportation dans RawToTrn, soit manuellement dans 

Landscape Editor). 

3. Le terrain sous les grands objets et les aéroports doit être aplati à nouveau. 

4. Les textures de terrain doivent être révisées. Les textures "dds", traitées à partir de V1, ne 

peuvent pas être utilisées directement, car elles sont tournées de 180 degrés. Encore une 

fois, plusieurs scénarios sont possibles : 

a. Si vous êtes satisfait de la résolution de texture de votre scène V1 et que vous avez 

toujours les textures de tuiles non traitées d'origines, vous pouvez les utiliser. Si vous 

les importez en utilisant Landscape Editor, elles seront coupées correctement en 

tuilettes. 

b. Si vous êtes satisfait de la résolution de texture de votre scène V1, mais que vous 

n'avez pas les textures de tuiles d'origine, vous devez les reconstruire à partir des 

tuilettes traitées. Utiliser "TextureRecomposer" pour ça. Vous pouvez ensuite les 

importer en utilisant "Landscape Editor". 



  Page 59 sur 64 

59 

 

c. Si vous n'aimez pas les textures originales en raison de leur apparence, de leur 

résolution, etc., vous devez en créer de nouvelles. Vous pouvez utiliser une 

résolution allant jusqu'à 8192 x 8192 par tuile. 

5. Si vous voulez avoir des plans d'eau avec des effets d'eau, vous devez ajouter un canal alpha avec 

des informations sur l'eau à vos textures. Voir le chapitre "Ajout des effets de plans d'eau" de notre 

tutoriel. 

6. Tous les objets d'une scène doivent être convertis du format original V1 CX au format C3D actuel. 

Heureusement, Condor le fait pour vous. Cela ne vous évitera pas de vérifier et d'éditer les fichiers 

un par un en utilisant l'éditeur d'objets. Comme le nom de la scène sera probablement différent, les 

chemins d'accès aux textures devront également être modifiés. Ne pas oublier de définir la couleur 

du matériau au blanc. Envisagez également de réorganiser la structure du dossier pour l'adapter à la 

manière proposée de stocker les objets et les textures. Voir le chapitre sur les objets et les aéroports 

de notre tutoriel. 

7. Tous les aéroports doivent être réaménagés, car leur structure est différente en V2. Seul le fichier 

O peut être utilisé après la conversion en C3D (voir l'étape précédente pour ne rien oublier), mais 

vous devez toujours créer un nouveau fichier G. Voir le chapitre sur la modélisation des aéroports 

personnalisés pour plus de détails. 

8. Vous devez créer de nouvelles cartes de forêt de conifères et de feuilles caduques, car V2 utilise 

une résolution beaucoup plus élevée que V1. 

9. Vous devez créer une nouvelle carte thermique de la scène. 

Donc, comme vous pouvez le voir, la conversion des scènes de V1 en V2 n'est vraiment pas un jeu 

d'enfant. Ce faisant, vous devriez vraiment considérer si l'effort en vaut la peine. 

Remplacer les données du terrain d'origine avec un maillage de 90 m par une version 

avec un maillage de 30 m en utilisant le fichier du terrain d'origine 
Ce processus n'est pas facile et s'il n'est pas fait correctement, il peut introduire des erreurs de 

précision dans votre nouvelle scène. 

Tout d'abord, vous devez télécharger les données d'altitude au pas de 30m comme décrit dans le 

tutoriel de scène. Faites toutes les étapes jusqu'à l'utilisation de la fonction de découpage, mais au 

lieu d'utiliser les coordonnées de notre scène de tutoriel, utilisez les coordonnées de votre scène V1. 

Fusionnez et projetez les données dans la zone UTM WGS 84 appropriée, mais ne les découpez pas. 

 

Attention: les textures de terrain sont stockées au format DDS, qui est un format 
compressé avec perte. TextureRecomposer lit les textures des tuilettes DDS et 
restaure les textures de tuiles au format BMP. Lorsque vous exportez des textures 
correctes à partir de "Landscape Editor", les images sont compressées en DDS, ce 
qui peut entraîner un certain niveau de dégradation de l'image. 

 

Si vos textures sont déjà ombrées, pensez à les retravailler à partir de zéro. Condor 
ombre maintenant le terrain et les objets en temps réel et les textures déjà 
ombrées peuvent sembler étranges. 
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Nous aurons besoin de tout. Notez les coordonnées UTM du coin supérieur gauche du terrain non 

recadré. 

Trouvez le fichier BIL créé lors de la projection et lisez sa largeur et hauteur à partir de son fichier 

HDR. Ouvrez "RawToTrn", définissez la largeur et la hauteur à partir du fichier HDR, cochez "flip 

verticaly" et "SRTM 30m" et chargez le fichier BIL. Lorsque le fichier se charge, enregistrez le 

"heightmap" du terrain en tant qu'image BMP. 

Puis cochez "SRTM 90m", "Swap with/height"(Permuter largeur/hauteur), "Flip Horizontal" 

(Retourner horizontalement) et décochez "Flip vertical" (Retourner verticalement). Chargez 

maintenant le fichier TRN à partir de la scène V1 d'origine. Enregistrez-le en tant que bitmap aussi. 

Pour la prochaine étape, nous utiliserons Paint.NET (vous pouvez utiliser n'importe quel autre éditeur 

graphique capable de travailler avec des calques). Chargez le bitmap enregistré dans le fichier BIL des 

élévations avec un maillage de 30 m, 

ensuite, ouvrez le fichier BMP enregistré à partir du fichier TRN d'origine. Redimensionner l'image à 

300%. Sélectionnez l'image redimensionnée, copiez-la dans le presse-papier et collez-la comme un 

nouveau calque sur la grande image à la résolution de 30 m. Définissez le mode de fusion du calque 

ajouté sur "Différence". 

Maintenant, déplacez le contenu de la couche pour l'aligner avec les données 30m. La couche est 

alignée lorsque la plus petite image devient noire. Cela signifie que toutes les caractéristiques de 

terrain de l'ancien terrain sont correctement alignées sur les nouvelles données au maillage de 30m. 

Une fois la couche alignée, nous devons trouver les coordonnées des pixels du coin supérieur gauche 

de la zone noire. Ce sont les décalages X et Y de l'origine 0,0 dans le coin supérieur gauche de l'image 

du terrain non recadrée. Nous allons les utiliser avec les dimensions de l'image bitmap 

redimensionnée à partir du TRN d'origine pour découper la carte de 30 m de hauteur pour notre 

scène. 

 

Figure 34 - Recherche des coordonnées du coin en haut à gauche (en surbrillance dans le rectangle rouge) avec Paint.NET 

Ouvrez "RawToTrn" et chargez le gros fichier BIL à nouveau, en utilisant les mêmes paramètres que 

précédemment. Passez à l'onglet "Crop" et sélectionnez "Exact crop". Entrez les décalages X et Y et la 

largeur et la hauteur du terrain redimensionné. 
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Passez à l'onglet "Save" (Enregistrer). Nous allons calibrer le nouveau terrain lors de l'exportation. 

Heureusement, nous connaissons les coordonnées UTM du coin supérieur gauche, donc les 

coordonnées d'étalonnage en haut à gauche peuvent être calculées comme suit : 

Point d'étalonnage TL easting = TLeasting + (30 * X offset) 

Point d'étalonnage TL northing = TLnorthing - (30 * Y offset) 

Remplissez la zone UTM, sélectionnez le coin supérieur gauche et remplissez les valeurs, Est et Nord, 

calculées. Cliquez sur "Save" (Enregistrer) sur le bouton TRN. Accédez au dossier dans lequel vous 

voulez enregistrer  

votre fichier TRN et n'oubliez pas de créer le sous-dossier "HeightMaps". "RawToTrn" va y enregistrer 

des tuilettes de terrain TR3. 

Comme nous avons étalonné le terrain lors de l'exportation, nous n'avons pas besoin de le faire dans 

"Landscape Editor". 

Restaurer le reste de la scène 
Maintenant que nous avons le nouveau terrain calibré, nous pouvons appliquer les textures de tuiles. 

Comme nous l'avons mentionné au début de ce chapitre, il existe plusieurs scénarios. Supposons que 

vous avez préparé les textures et qu'elles sont placées dans le dossier \Working \Terragen\Textures. 

Chargez-les dans "Landscape Editor" et vous devriez voir votre nouveau terrain recouvert de textures 

(plus de détails sur l'utilisation des textures dans Landscape Editor se trouvent dans le chapitre 

correspondant de notre tutoriel). Vous pouvez les exporter vers Condor pour les premiers tests. 

Si vous souhaitez ajouter un canal alpha aux plans d'eau dans les textures, lisez le chapitre "Ajout des 

effets de plans d'eau" du tutoriel. Les textures avec canal alpha des plans d'eau ne doivent pas être 

exportées depuis "Landscape Editor" ! Utilisez plutôt l'outil "Water Alpha". 

Créez les deux cartes de forêt (voir le chapitre correspondant dans le tutoriel pour plus de détails), 

importez-les dans Landscape Editor et exportez-les dans Condor. 

Mettez tous les objets CX de la scène V1 dans le même dossier dans votre scène V2. Copiez le fichier 

landscape.obj avec la définition du placement des objets dans la nouvelle scène V2 et renommez-le 

en conséquence. Lorsque vous commencez un vol sur cette scène, Condor les convertira au format 

C3D. Cependant, vous devez toujours vérifier chaque objet converti manuellement à l'aide de 

l'éditeur d'objets. Définissez la couleur du matériau de tous les objets texturés à 1.0, 1.0, 1.0 (blanc) 

et corrigez les chemins de texture. Sinon, les textures n'apparaîtront pas dans Condor. 

Le fichier de définition des aéroports V1 peut également être utilisé dans V2. Cependant, vous devrez 

remodeler au moins le fichier G pour chacun des aéroports. Désolé. 

Comme le modèle thermique V2 diffère du V1, vous devez ajuster ou retravailler complètement la 

carte thermique. Voir le chapitre correspondant du tutoriel. 

Voilà, votre ancienne scène devrait maintenant être prête à être utilisée avec Condor 2. 

 

N'utilisez JAMAIS l'ancien fichier TRN de la scène originale V1 avec les nouveaux 
fichiers heightmap TR3 ! Cela peut provoquer un comportement imprévisible. 
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9. Annexe 1 

Calibrage manuel du terrain 
Comme le terrain est étalonné automatiquement lors de l'exportation depuis "RawToTrn", il n'est 

plus nécessaire de le calibrer manuellement dans "Landscape Editor", sauf si vous en avez vraiment 

besoin pour une raison quelconque. 

Si vous avez enregistré le fichier CalibrationPoints.csv dans "UTMtools", déplacez ce fichier vers le 

dossier Condor2\Landscapes\Tutorial\Working (si le dossier \Working est manquant, créez-le). Cela 

rendra l'étalonnage de la scène beaucoup plus facile. 

Cochez la case "Calibration points" (Points d'étalonnage) pour afficher les points d'étalonnage de la 

scène. Cliquez sur la fonction "Calibration points" (Points d'étalonnage pour l'activer). Notez qu'une 

liste de points d'étalonnage apparaît sous la boîte à outils. Si vous utilisez "CalibrationPoints.csv" 

enregistré depuis "UTMtools", vous devriez maintenant voir quatre points d'étalonnage. S'ils ne sont 

pas là, vérifiez si le fichier est placé dans le bon dossier ou si le nom est réellement 

"CalibrationPoints.csv". Si vous voyez les points d'étalonnage, vous n'avez pas à suivre les étapes 

décrites dans les quelques paragraphes suivants et vous pouvez passer au point d'utilisation du 

bouton "Calibrate" (Calibrer). 

 

Si vous n'utilisez pas le fichier csv de "UTMtools", vous avez deux choix: vous pouvez créer ce fichier 

vous-même ou calibrer la scène manuellement. 

Pour créer le fichier CalibrationPoints.csv, nous devons connaître les coordonnées décimales 

latitude/longitude des 4 coins et la taille de la scène en mètres. Lorsque vous utilisez les quatre coins 

de la scène, le "CalibrationPoints.csv" a le contenu suivant (les points d'étalonnage sont placés dans 

le sens des aiguilles d'une montre à partir du coin supérieur gauche) : 



  Page 63 sur 64 

63 

 

WidthMeters, HeightMeters, top left lat, top left lon 

0, HeightMeters, top right lat, top left lon 

0, 0, bottom right lat, bottom right lon 

WidthMeters, 0, bottom left lat, bottom left lon 

Le séparateur décimal doit être le point décimal ("."). Le contenu du fichier pour l'exemple du tutoriel 

de ce guide serait alors le suivant : 

46080,46080,49.9967006118126,15.2894438698528 

0,46080,49.9933159136275,15.9323143813137 

0,0,49.5789090178296,15.924394186348 

46080,0,49.5822447416054,15.2869845996996 

Enregistrez le fichier "CalibrationPoints.csv" avec ce contenu dans le dossier "\Tutorial\Working" et 

redémarrez "Landscape Editor" (l'éditeur de scène). Après avoir à nouveau ouvert votre scène 

Tutorial, vous devriez voir les points d'étalonnage sous la forme d'une liste dans la fenêtre de texte. 

Vous pouvez ensuite ignorer les paragraphes suivants jusqu'à l'étape d'utilisation du bouton 

"Calibrate" (Calibrer). 

Pour effectuer le calibrage manuellement, sans utiliser le fichier "CalibrationPoints.csv", nous devons 

placer les 4 points de calibrage le plus près possible des 4 coins de la scène (idéalement dans le coin). 

Cliquez sur l'icône de la main pour activer le mode panoramique et zoom. Nous pouvons déplacer le 

terrain dans la fenêtre en le faisant glisser tout en maintenant le bouton gauche de la souris 

enfoncée. Un clic gauche incrémente le niveau de zoom sur le terrain et un clic droit décrémente le 

niveau de zoom. Cochez la case "Draw zoom status" (Afficher l'état du zoom) pour voir le niveau de 

zoom en cours. 

Commençons à ajouter des points d'étalonnage que nous avons calculés précédemment. Effectuez 

d'abord un zoom avant sur le haut à gauche du terrain - maintenez le bouton gauche de la souris 

jusqu'à ce que vous voyiez le niveau de zoom à 42,67, qui est le zoom maximum. Maintenant, cliquez 

sur l'icône de la flèche et déplacez le curseur de la souris aussi près que possible du coin du terrain. 

Voir les indicateurs PosX et PosY dans la barre d'état. Ils vous indiquent les coordonnées actuelles en 

mètres du point d'origine dans le coin inférieur droit. Comme la taille de notre scène "Tutorial" est de 

46080 x 46080 mètres, nous cherchons à placer le point d'étalonnage en haut à gauche aussi près 

que possible de la position 46080, 46080. Lorsque vous pensez qu'il est assez proche (46080, 46080 

dans le cas idéal), faites un clic droit pour ouvrir le menu contextuel, puis cliquez sur "Add calibration 

point here" (Ajouter un point d'étalonnage) ici. Une petite boîte de dialogue demandant la paire de 

coordonnées de latitude et de longitude s'ouvre. Entrez les coordonnées que nous avons calculées 

plus tôt ou copiez les coordonnées d'étalonnage à partir de "UTMtools" (en double-cliquant sur la 

valeur, vous les copiez dans le presse-papier). 

Notez que "Landscape Editor" accepte uniquement le point comme séparateur décimal. Si vos 

paramètres locaux utilisent un séparateur décimal différent, vous devez le remplacer par un point 

avant de cliquer sur "OK" dans la boîte de dialogue. 
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L'utilisation des coins, supérieur gauche et inférieur droit, devrait être suffisant pour calibrer le 

terrain, mais pour notre exemple, nous allons ajouter un point d'étalonnage de chacun des 4 coins. 

 

Une fois que tous les points d'étalonnage sont en place, nous pouvons cliquer sur le bouton 

"Calibrate" (Calibrer). "Landscape Editor" vous demandera si vous voulez vraiment calibrer à nouveau 

le terrain. Cliquez sur "OK" pour commencer. Nous pouvons immédiatement voir l'effet de 

l'étalonnage lorsque vous déplacez le curseur de la souris sur le terrain - les indicateurs Lat. et Long., 

dans la barre d'état, indiquent maintenant la latitude et la longitude en valeur décimale du point sur 

lequel pointe le curseur. 


